
 

 
Apelon, Inc. 
Suite 202, 100 Danbury Road 
Ridgefield, CT 06877 
 

    Phone: (203) 431-2530
Fax: (203) 431-2523

www.apelon.com

 

 

 

 

 

 

Apelon Distributed Terminology System (DTS) 
 

DTS Editor Users Guide 
 

 

 

 

 

 

 

 

 

 

 

 



 

© 1999-2009 Apelon, Inc.  All Rights Reserved. 

            Page 2 of 147 

 
 

Table of Contents 

Introduction...................................................................................................................... 7 

Namespaces .................................................................................................................. 7 

Ontylog Namespaces................................................................................................. 7 

Ontylog Extension Namespaces................................................................................ 7 

Thesaurus Namespaces ............................................................................................. 8 

Subsets of Namespaces ............................................................................................. 8 

Purpose of This Guide .................................................................................................. 8 

Connect to the DTS Editor ........................................................................................... 9 

Connection and Logon .............................................................................................. 9 

Socket Server Connection ....................................................................................... 10 

Secure Socket Server Connection ........................................................................... 10 

JDBC Local Connection.......................................................................................... 11 

Content License Agreements...................................................................................... 12 

Disconnect From the DTS Editor ............................................................................... 13 

Set Current Local Namespace .................................................................................... 14 

The DTS Editor Main Window...................................................................................... 15 

Modify Main Window Panel Sizes............................................................................. 16 

DTS Editor Main Window Menu Options ................................................................. 16 

File Menu ................................................................................................................ 16 

View Menu.............................................................................................................. 17 

Tools Menu ............................................................................................................. 17 

Options Menu.......................................................................................................... 19 

Help ......................................................................................................................... 19 

DTS Editor Main Window Toolbar Options .............................................................. 19 



 

© 1999-2009 Apelon, Inc.  All Rights Reserved. 

            Page 3 of 147 

 
 

DTS Editor Main Window Tab View Options........................................................... 21 

DTS Editor Keyboard Options ................................................................................... 22 

View Concept Tree – Tree Tab .................................................................................. 22 

Concept Tree Panel Display Preferences.................................................................... 23 

Ontylog Tree Preferences........................................................................................ 23 

Classic View............................................................................................................ 23 

Container View ....................................................................................................... 24 

Inline View.............................................................................................................. 25 

Icons and Colors...................................................................................................... 25 

Concept Name and Attribute Text Wrapping ......................................................... 26 

Click to Edit (Ontylog or Thesaurus Tree).............................................................. 27 

Multiple Panel Instances............................................................................................. 27 

Customize the Tree View ........................................................................................... 28 

Hierarchy Tree View............................................................................................... 28 

Association Tree View............................................................................................ 29 

View Concepts in a Selected Namespace Subset.................................................... 31 

Concept Walker View ................................................................................................ 33 

Hierarchy View ....................................................................................................... 33 

Association View .................................................................................................... 36 

View Subset Concepts in the Concept Walker........................................................ 37 

Concept Name and Attribute Text Wrapping ......................................................... 38 

Concept Search .............................................................................................................. 40 

Search for Concepts or Terms Based On Name......................................................... 44 

Search for Concepts With Selected Synonyms .......................................................... 45 

Search for Concepts With Selected Properties ........................................................... 47 

Search for Concepts Using the Word Match Feature.............................................. 48 



 

© 1999-2009 Apelon, Inc.  All Rights Reserved. 

            Page 4 of 147 

 
 

Search For Concepts With Selected Roles ................................................................. 50 

Search for Concepts With Selected Inverse Roles ..................................................... 52 

Search for Concepts With Selected Concept Associations ........................................ 53 

Search for Concepts With Selected Inverse Concept Associations............................ 55 

Search for Concepts in a Knowledgebase “Silo” ....................................................... 57 

Search for Concepts in a Namespace Subset.............................................................. 60 

Namespace Maintenance ............................................................................................... 62 

Overview .................................................................................................................... 62 

Ontylog Namespaces............................................................................................... 62 

Thesaurus Namespaces ........................................................................................... 63 

Connection Namespaces ......................................................................................... 63 

Current Local Namespace .......................................................................................... 64 

Create a Local Namespace ......................................................................................... 65 

View and Edit an Existing Namespace....................................................................... 68 

Delete a Local Namespace ......................................................................................... 71 

Authority View and Maintenance............................................................................... 72 

Create an Authority ................................................................................................. 72 

View an Existing Authority for a Local Namespace............................................... 73 

Delete an Authority ................................................................................................. 74 

Association Maintenance ............................................................................................... 75 

Association Types....................................................................................................... 75 

Create Association Types........................................................................................ 75 

View and Edit an Association Type........................................................................ 77 

Delete an Association Type..................................................................................... 79 



 

© 1999-2009 Apelon, Inc.  All Rights Reserved. 

            Page 5 of 147 

 
 

Association Qualifier Types ....................................................................................... 80 

Create Association Qualifier Types ........................................................................ 80 

View and Edit an Association Qualifier Type ........................................................ 82 

Delete an Association Qualifier Type ..................................................................... 84 

Create Associations .................................................................................................... 85 

Filter Association Types.......................................................................................... 87 

Filter Association Qualifier Types .......................................................................... 89 

Synonym Maintenance................................................................................................... 91 

Create Synonyms........................................................................................................ 91 

Property Maintenance .................................................................................................... 94 

Property Types............................................................................................................ 94 

Create Property Types............................................................................................. 94 

View and Edit a Property Type ............................................................................... 96 

Delete a Property Type............................................................................................ 98 

Property Qualifier Types ............................................................................................ 99 

Create Property Qualifier Types ............................................................................. 99 

View and Edit a Property Qualifier Type.............................................................. 101 

Delete a Property Qualifier Type .......................................................................... 103 

Assign Properties to a Concept................................................................................. 104 

Filter Property Types............................................................................................. 106 

Filter Property Qualifier Types ............................................................................. 108 

Concept Maintenance................................................................................................... 111 

View Concept/Term Details ..................................................................................... 111 

Configure Concept/Terms Details Panel View ..................................................... 112 

Navigate to Other Concepts or Terms From Displayed Detail ............................. 114 

View Subsets in Which a Concept Resides........................................................... 116 



 

© 1999-2009 Apelon, Inc.  All Rights Reserved. 

            Page 6 of 147 

 
 

Concept Name and Attribute Text Wrapping ....................................................... 117 

View Concept/Term Details Panel History Using Forward and Back Buttons .... 118 

Add a New Concept/Term to a Local Namespace ................................................... 119 

Create the New Concept........................................................................................ 119 

Change the Name of a Concept............................................................................. 120 

Add a Synonym to a Concept ................................................................................... 120 

Edit a Synonym ........................................................................................................ 124 

Delete a Synonym..................................................................................................... 125 

Add a Property to a Concept or Term....................................................................... 125 

Edit a Concept Property............................................................................................ 128 

Delete a Concept Property........................................................................................ 130 

Create an Association ............................................................................................... 130 

Create a Concept/Term Association within a Namespace .................................... 135 

Map Concept/Terms across Namespaces.............................................................. 137 

View and Edit an Existing Association .................................................................... 140 

Delete an Association ............................................................................................... 141 

Code and ID Generator ................................................................................................ 142 

Introduction ........................................................................................................... 142 

Writing and Compiling a Code and ID Generator ................................................ 142 

Registering a Code and ID Generator ................................................................... 144 

Duplicate Codes .................................................................................................... 145 

Sample Code and ID Generator ............................................................................ 146 

Appendix A – Adjust Memory for Remote JDBC Connections.................................. 147 



 

© 1999-2009 Apelon, Inc.  All Rights Reserved. 

               Page 7 of 147 

Introduction 
The viewing tool in the DTS Editor allows you to view subscription content in Ontylog 
and Thesaurus namespaces within your knowledgebase (in DTS each namespace 
represents a separate source terminology).  All of your namespaces together comprise 
your knowledgebase.  You can configure a tree display for a broad view of a selected 
subscription namespace, then select an individual item (e.g., concept, term) for which to 
view detailed information.  

The edit functions in the DTS Editor allow you to create and maintain new content in one 
or more local namespaces.  Each user-defined local namespace that you create can 
contain new concepts and/or terms that reside outside of any of your subscription 
namespaces.   

In the local namespace you also can map relationships (i.e., create associations) between 
selected concepts or terms in your local content, and specific concepts or terms in 
subscription namespace content.  For example, you can create a mapping between a 
single concept in an Ontylog subscription namespace, and a newly created synonymous 
term in your local namespace.   

Namespaces 

Ontylog Namespaces 
An Ontylog namespace is one created using the Ontylog language, developed using 
Apelon’s Terminology Development Environment (TDE) product.  TDE, and Ontylog, 
allow you to build and maintain knowledgebases through the use of description logic. 
Concepts and terms in Ontylog are organized into a taxonomy through a process called 
classification.  Refer to the Ontylog Namespaces discussion later in this guide for more 
on Ontylog namespaces.  

Ontylog Extension Namespaces 
You cannot perform edits directly to an Ontylog-type subscription namespace using the 
DTS Editor.  Using the DTS Editor, you can (locally) create new concepts and concept 
relationships for each Ontylog subscription namespace by creating an Ontylog Extension 
namespace.   

You link the Ontylog Extension local namespace to the specific Ontylog subscription 
namespace for which you want to add or modify content.  Each Extension namespace is 
comprised of supplemental content that you create locally, content that you can classify 
against the linked Ontylog subscription content.   

Classification of a namespace produces the namespace’s inferred view, which takes 
concept and role relationships into account.  If necessary, classification positions 
concepts in the namespace hierarchy based on these relationships.   
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You may link each Extension namespace to only a single Ontylog subscription 
namespace.  You can, however, create multiple Extension namespaces that link to the 
same Ontylog subscription namespace.   

Refer to the Ontylog Extension Namespaces and Extension Namespace Classification in 
DTS document for procedures on creating and classifying Ontylog Extension 
namespaces, and for instructions on installing and deploying the files necessary to 
perform classification. 

Thesaurus Namespaces 
A Thesaurus namespace in DTS is one in which concepts and terms are organized based 
on relationships (associations) with other concepts.  The DTS Editor provides view 
capabilities for subscription namespaces with the type of Thesaurus.  You can create a 
new “local” namespace that is a Thesaurus type.  In the local namespace you can create 
new content, and establish mappings to content in subscription namespaces (both Ontylog 
and Thesaurus) as well as other local namespaces.  Refer to the Thesaurus Namespaces 
discussion later in this guide for more on Thesaurus namespaces.    

Subsets of Namespaces 
A subset is a segment of concepts that you can create from a specific namespace, based 
on selection parameters that you define.  Using the Subset Editor functions available to 
you from the DTS Editor Main window, you can create and maintain a subset from a 
subscription or local namespace, or from a (classified) extension namespace.  If the 
namespace you are viewing in the DTS Editor has one or more subsets created for it, you 
can highlight each concept in the view that was selected for a subset.  Refer to the DTS 
Subset Editor Users Guide for procedures on subset creation and maintenance in DTS.   

Purpose of This Guide 
This guide includes procedures for using the view capabilities in the DTS Editor to create 
tree views of subscription content in Ontylog and Thesaurus namespaces.  Detail views 
are available for each selected concept/term in a tree view.  Illustrations of different view 
scenarios are provided.   

The guide also includes procedures for adding and maintaining one or more local 
namespaces, as well as the new content within.  This content includes new concepts 
and/or terms, and the attributes related to each (e.g., properties, associations).  Procedures 
for creating new associations between concepts and/or terms within a namespace are 
provided, as well as procedures for creating associations across namespaces.  Illustrated 
examples are included.  
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Connect to the DTS Editor 

Connection and Logon 
Follow this procedure to establish a connection to the server where your knowledgebase 
resides.  If you intend to use a secure socket connection, confirm that the user has been 
created before you start the DTS Editor; refer to the Managing Users discussions in the 
Apelon DTS Server Operations Guide for procedures on adding and maintaining users. 

Start the DTS Term Editor from the Windows Start menu (Start>Programs> 
Apelon>DTSInstall>Apelon DTS Editor, where DTSInstall represents the current 
version).  If there is a shortcut for the DTS Editor, click the shortcut icon.  The DTS 
Editor Main window displays.  

 
At this point you must specify the desired connection to the DTS Server.  Select Connect 
Options from the File menu.  When the Connect Options window displays, click on the 
dropdown field to display the available connection options. 
 

 
Select a Socket server connection, Secure Socket server connection, or a JDBC Local 
connection.  To use a secure socket connection, the DTS Server must be configured to 
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use Secure Server Mode, and a user must have been created.  Click OK.  In the following 
discussions, refer to the procedures specific to the connection type you selected. 

Socket Server Connection 
1. Confirm that the Apelon DTS Server is running (Start>Programs>Apelon> 

DTSInstall>Start Apelon DTS Server). 

2. Select Socket Server Connection from the Connect Type Option dropdown field, 
then click OK.  

3. Select Connect from the DTS Editor Main window File menu.  The Connect to 
Apelon Server window displays. 
 

 
4. Specify the connection Host and Port for the DTS Server (i.e., the name of the 

machine where your DTS Server is running).  To recall these values for future 
sessions, click Use these values as defaults.  

5. Click Connect to establish the socket server connection to with your DTS Server. 
The Content License Agreements window displays.   

Secure Socket Server Connection 
1. Confirm that the Apelon DTS Server is running (Start>Programs>Apelon> 

DTSInstall>Start Apelon DTS Server). 

2. Select Secure Socket Server Connection from the Connect Type Option dropdown 
field, then click OK. 

3. Select Connect from the DTS Editor Main window File menu.  The Connect to 
Apelon Server window displays. 
 

 
4. Enter your Host name (for the machine where your DTS Server is running) and 

Port number to access the DTS Server, your Username, and Password.  To recall 
these values for future sessions, click Use these values as defaults.  
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5. Click Connect to establish the secure socket server connection to with your DTS 
Server.  The Content License Agreements window displays.     

JDBC Local Connection 
When you install DTS (using the InstallShield wizard) you must specify the type of 
database (Oracle or Microsoft SQL Server database) on which you will maintain your 
DTS data, as well as the driver through which the DTS Server and the DTS Editor will 
access that data.  The appropriate DTS configuration files (e.g., drivers.xml) are updated 
to reflect your selection.   

If you maintain the knowledgebase in a Microsoft SQL Server database, you have the 
option of using either of these drivers: 

• Microsoft JDBC driver (the required SQL Server JDBC driver is installed 
automatically. 

• I-Net Sprinta JDBC driver (Apelon recommends that you obtain and install the 
iSprinta Enterprise™  driver, which provides the multiple connections required 
to use DTS). 

1. Select JDBC Local Connection from the Connect Type Option dropdown field, 
then click OK.  

2. Select Connect from the DTS Editor Main window File menu.  The Connect to 
Database window displays. 
 

 
3. Enter your Username, Password, and Host name (for the machine where your 

database is located).  To recall these values for future sessions, click Use these 
values as the defaults.  

4. If your configuration requires you to modify the default Oracle instance and port 
designations, or to choose SQL Server, click on Advanced. The Advanced Setup 
window displays. 
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5. If you choose Oracle – Thin Client Driver in the Database/Driver field, you can 
accept the default database name in the Database name/instance field, and the 
default port number in the Port field, or override the defaults to connect to the 
desired database.  Click OK. 
  - If you indicated during DTS installation that you maintain your DTS  
    knowledgebase in a Microsoft SQL Server database, and you have  
    obtained and installed the iSprinta Enterprise driver, then SQL Server –  
    Sprinta Driver is included as an option in the Database/Driver field.   
 
  - If you indicated during DTS installation that you maintain your DTS  
     knowledgebase in a Microsoft SQL Server database, and selected the  
     Microsoft driver that is provided with DTS, then SQL Server – Microsoft is  
     included as an option in the Database/Driver field.   
 
In the displayed Database/Driver field, specify your SQL Server/driver selection.  
In the displayed Instance field, specify the SQL Server named instance (if you are 
using a default instance, leave the field blank). 

6. Click Connect on the Connect to Database window to establish the JDBC 
connection.  The Content License Agreements window displays.   

Content License Agreements 
The Content License Agreement(s) window displays immediately after you establish your 
database connection.   
 

 
In order to use the DTS Editor, use the Scroll Bar to list license terms for all of the 
vocabularies to which you subscribe.  Click Yes (which is enabled after you read the 
entire agreement) to accept the terms; the DTS Editor Main window redisplays. 
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Disconnect From the DTS Editor 
Select Disconnect from the File menu, or click the toolbar Disconnect icon.  If there is 
unsaved data (new or modified) in one of the DTS Editor components, the following 
confirmation window displays. 
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Click Yes to close the component and disconnect without reviewing or updating unsaved 
data; displayed floating panels are closed when you disconnect.  Click Cancel to 
disregard the disconnect request.  

Set Current Local Namespace 
When you first log into the DTS Editor you have the option to set a current local 
namespace.  Select Set Current Local Namespace from the Options menu, or select 
the Set Current Local Namespace icon from the Main window toolbar options.  The Set 
Current Local Namespace window displays.   

 
The namespace selected here becomes the default local (writable) namespace for the 
addition and maintenance of property types, association types, and qualifier types to be 
used when you add local content to a subscription namespace. 

Thereafter, you can add a new property, synonym, or association to a concept or term in a 
subscription namespace, or add a qualifier to a property or an association, as long as the 
appropriate attribute type (e.g., property type) exists in the current local namespace.  
You have the option of changing the local namespace at a later time.  Attributes added in 
this manner to a concept or term in a subscription namespace are listed in italics in the 
Concept/Term Details View, as well as in the Concept Tree View (Container and 
Inline versions of the view).  Note the illustration.  

 
The attributes themselves actually are written to the local namespace.  No database 
updates occur for the subscription namespace itself.  Refer to the Ontylog Extension 
Namespaces and Extension Namespace Classification in DTS document for procedures 
on creating an Ontylog Extension namespace that you can employ as a local namespace. 

Local Namespace Content in Italics 
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The DTS Editor Main Window 
The DTS Editor Main window displays as soon as you accept the terms of the Content 
License Agreements (click Yes on the Content Licenses Agreements window).  The DTS 
Editor version number displays in the window header.  The window consists of two main 
display panes.  The panels available in the left pane of the window relate to global 
navigation and viewing tasks.   

When the window first opens, the Tree tab is selected and the Concept Tree panel 
displays in the left pane.  When you select a namespace from the Namespace dropdown 
field, this tree unfolds the taxonomy to display the concept hierarchy for the selected 
namespace in the knowledgebase.   

 
You can navigate through the concept tree to locate concepts for view. 

The Concept/Term Details panel displays in the right pane.  Here you may view concept 
details, edit concept properties locally, and add new concepts.  Each of these panels is 
discussed in more detail later in the guide. 

The Status Bar located at the bottom of the window indicates whether or not you are 
connected to the database.  The DTS Server connection host and port display as well. 

The Windows Text Edit functions Cut, Copy, and Paste are available in many of the 
DTS Editor data entry fields through keyboard shortcuts (CTRL-X, CTRL-C, and 
CTRL V, respectively). 
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Modify Main Window Panel Sizes 
You can modify the display by clicking and dragging the edge of the pane you want to 
resize.  Note the resized panes in the following illustration. 

 
The resized panel settings are retained if you disconnect from the DTS Server, then 
reconnect. 

DTS Editor Main Window Menu Options 

File Menu 
Connect - Establishes your connection to the DTS Server and the knowledgebase (you 
also can click the Connect icon in the toolbar). 

Disconnect - Disconnects you from the DTS Server and the knowledgebase (you also can 
click the Disconnect icon in the toolbar).   

Connect Options - Displays connection options on the Connect Options window; select 
the desired connection type to the DTS Server, or a direct connection to a database. 

Exit - Ends this DTS Editor session and exits the program. 
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View Menu  
Status Bar - Lets you toggle the Status Bar on or off.  The Status Bar, located at the 
bottom of the window, indicates if you are connected to the knowledgebase, and 
identifies the user and host connection. 

Tools Menu 
New Concept Tree - Displays the Concept Tree panel as a floating window (you also 
can click the Open New Tree icon in the toolbar).  Use this window in addition to the 
Concept Tree panel, which you can display by clicking the Tree tab in the left pane.  

New Concept Walker - Displays the Concept Walker panel as a floating window (you 
also can click the toolbar’s Open New Walker icon).  Use this window in addition to the 
Concept Walker panel, which you can display by clicking the Walker tab in the left pane.    

New Search - Lets you open the Search panel as a separate window (you also can click 
the Search icon in the toolbar).  The Search panel allows you to search for a concept 
based on the parameters you specify.  Use this window as an alternative to the Search 
panel, which you can display by clicking the Search tab in the left pane. 

Concept/Term Details - Displays the Concept/Term Details popup window (you also 
can click the Open New Details Panel icon in the toolbar.  The Concept/Term Details 
window lists detailed information for any concept you drag and drop on the window from 
anywhere else in the application.   

Associations - Displays the Association Editor floating window, which allows you to 
create and maintain associations between concepts or terms within the same namespace, 
or across namespaces (you also can click the Open Association Editor icon in the 
toolbar).  For each association you can specify one or more established qualifier types 
and values; these provide additional detail regarding the nature of a concept or term 
association (e.g., Usually).      

Properties - Displays the Property Editor floating window, which allows you to view, 
create, and maintain properties for a concept or term (you also can click the toolbar’s 
Open Property Editor icon).  A property is a piece of user-defined information that can 
be linked to a concept or term, and can be used for any purpose.  For each property you 
can specify one or more established qualifier types and values; these provide additional 
detail regarding the nature of a concept or term property (e.g., Current).     

Synonyms - Displays the Synonym Editor floating window, which allows you to 
establish a synonymous term for a concept (you also can click the Open Synonym 
Editor icon in the toolbar). 

Association Types - Each association you create between two concepts or terms must be 
assigned a specific type to indicate the nature of the relationship (e.g., one concept is 
Broader Than the other, or is a Parent of the other).  Click this option to display the 
Association Types window, which allows you to view, create, and maintain association 
types. 
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Property Types - Each property that is assigned to a concept has a property type, which 
defines the nature of the property (e.g., Document, Code).  Multiple values can be 
related to each property type.  Click this option to display the Property Types window, 
which allows you to view, create, and maintain property types.  

Qualifier Types - Qualifier types, and their associated values, provide additional detail 
regarding the nature of a concept or term property (e.g., Current) or a concept or term 
association (e.g., Usually).  Click this option to display the Qualifier Type Editor floating 
window, which allows you to view, create, and maintain qualifier types.   

Kinds - Displays the Kind Viewer floating window, which lists all kinds that have been 
defined within all of the Ontylog namespaces in your knowledgebase.  Each concept in 
an Ontylog namespace must be assigned a kind to identify the concept’s type (specimen, 
procedure, etc.).   
 
This listing of established kinds may be helpful if you define new concepts in an Ontylog 
Extension namespace.  Refer to the Create and Maintain Ontylog Extension Namespaces 
discussions in the Ontylog Extension Namespaces and Extension Namespace 
Classification in DTS document for more on concept kinds.      

Role Types - Displays the Role Type Viewer floating window, which lists all roles that 
have been defined within the Ontylog namespaces in your knowledgebase.  Each concept 
in an Ontylog namespace can be assigned one or more roles (each defined by a Role 
Type); each role describes a user-defined relationship between different established 
kinds.   
 
This listing of established role types may be helpful if you define new concepts in an 
Ontylog Extension namespace.  Refer to the Create and Maintain Ontylog Extension 
Namespaces discussions in the Ontylog Extension Namespaces and Extension 
Namespace Classification in DTS document for more on concept roles.      

Namespace - Displays the Namespace Editor floating window, which allows you to 
view, create, and maintain the namespaces in your knowledgebase. 

Classify - This option is enabled only if the current local namespace is an Ontylog 
Extension namespace.  Click this option to perform classification on the current 
Extension local namespace (you also can click the Classify icon in the toolbar).  Refer to 
the Classify an Ontylog Extension Namespace discussions in the Ontylog Extension 
Namespaces and Extension Namespace Classification in DTS document for more on 
Ontylog Extension namespace classification. 

Classify Errors - This option is enabled only if the current local namespace is an 
Ontylog Extension namespace.  Click this option to display the Classify Errors window, 
which lists errors that occurred during classification of the current Extension local 
namespace.  Refer to the Classify an Ontylog Extension Namespace discussions in the 
Ontylog Extension Namespaces and Extension Namespace Classification in DTS 
document for more on Ontylog Extension namespace classification. 
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New Subset List - Opens the DTS Editor Subset List panel as a floating window (you 
also can click the Open Subset List Panel icon in the toolbar).  The Subset List panel 
allows you to search for and list the namespace subsets that are available in your DTS 
knowledgebase.  Refer to the DTS Subset Editor Users Guide for procedures on creating 
and maintaining DTS subsets. 

New Subset Editor - Opens the DTS Editor Subset Expression Editor panel as a floating 
window (you also can click the Open Subset Expression Editor icon in the toolbar).  
The Subset Expression Editor panel allows you to edit the filters through which 
namespace subsets are created.  Refer to the DTS Subset Editor Users Guide for 
procedures on creating and maintaining DTS subsets. 

Options Menu  
Code and ID Generator - Concept codes and IDs are concept identifiers generated 
automatically and assigned to each new concept you create using the DTS Editor.  The 
options available here allow you to customize the format of the codes and IDs assigned to 
new concepts. 

Set Current Local Namespace – Lets you select the default local namespace, in which 
you can add and maintain local content for a subscription namespace.  You also can click 
the Set Current Local Namespace icon in the toolbar.       

Help  
Help Topics - Provides online help (you also can click the Help icon in the toolbar).  

About DTS Editor – The DTS Editor version, copyright date, etc. 

DTS Editor Main Window Toolbar Options 
Most of the options available from the menus on the DTS Editor Main window also are 
available from the window toolbar.  

 

 Connect to DTS Server - Establishes your connection to the DTS Server and the 
knowledgebase (you also can click Connect in the File menu). 
 

 Disconnect - Disconnects you from the DTS Server and the knowledgebase  
(you also can click Disconnect in the File menu). 
 

 Open New Tree - Displays the Concept Tree panel as a floating window (you  
also can click New Concept Tree in the Tools menu).  Use this window in conjunction 
with the Concept Tree panel that you can display by clicking the Tree tab in the left pane.  
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 Open New Walker - Displays the Concept Walker panel as a floating window  
(you also can click New Concept Walker in the Tools menu).  Use this window in 
conjunction with the Concept Walker panel that you can display by clicking the Walker 
tab in the left pane.   
 

 Search – Displays the Search panel as a separate window (you also can click  
New Search in the Tools menu).  The Search panel allows you to search for a concept 
based on the parameters you specify.  Use this window in conjunction with, or as an 
alternative to, the Search panel that you can display by clicking the Search  
tab in the left pane. 
 

 Set Current Local Namespace - Allows you to select the default local  
namespace, to which you can add and maintain local content for a subscription 
namespace (you also can click Set Current Local Namespace in the Options menu).   
 

 Classify - This icon is enabled only if the current local namespace is an Ontylog 
Extension type namespace.  Click to perform classification on the current Ontylog 
Extension local namespace (you also can click Classify in the Tools menu).  Refer to the 
Classify an Ontylog Extension Namespace discussions in the Ontylog Extension 
Namespaces and Extension Namespace Classification in DTS document for more on 
Ontylog Extension namespace classification. 
 

 Open New Details Panel - Displays the Concept/Term Details popup  
window, which lists detailed information for any concept you drag and drop on the 
window from anywhere else in the application (you also can click Concept/Term Details 
in the Tools menu).   
 

 Open Association Editor - Displays the Association Editor floating window,  
which allows you to create and maintain associations between concepts or terms within 
the same namespace, or across namespaces (you also can click Associations in the Tools 
menu).   
 

 Open Synonym Editor - Displays the Synonym Editor floating window,  
which allows you to establish a synonymous term for a concept (you also can click 
Synonyms in the Tools menu).   
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 Open Property Editor - Displays the Property Editor floating window, which  
allows you to view, create, and maintain properties for selected concepts (you  
also can click Properties in the Tools menu).    
 

 Open Subset List Panel - Displays the Subset List floating window (you also can 
click New Subset List in the Tolls menu).  The Subset List panel lists the namespace 
subsets that are available in your DTS database.  Refer to the DTS Namespace Subset 
Editor Users Guide for procedures on creating and maintaining DTS subsets. 
 

 New Subset List - Displays the Subset Expression Editor floating window (you 
also can click New Subset Editor in the Tools menu).  The Subset Expression Editor 
panel allows you to edit the filters through which namespace subsets are created.  Refer 
to the DTS Namespace Subset Editor Users Guide for procedures on creating and 
maintaining DTS subsets. 
 

 Help - Provides online help (you also can click Help Topics in the Help  
menu).  

DTS Editor Main Window Tab View Options  
The following “tab” options are available when the DTS Editor Main window opens 
initially.  Each brief introduction that follows outlines the view panel displayed when you 
click the appropriate tab.  Detailed procedures and discussions on use of these panels are 
provided later in the guide. 

Tree - The Concept Tree view panel displays as the default in the left pane when the 
main window first opens.  When either of the other panels (Search or Concept Walker) 
displays in the left pane, click the Tree tab to redisplay the concept tree.  This tree 
unfolds the taxonomy to display the concept hierarchy in a selected namespace in the 
knowledgebase, or an association tree.   

Walker - Displays the Concept Walker panel, which lists the parents and children of a 
concept in the selected namespace. 

Search - Displays the Search panel, which allows you to search for concepts based on the 
parameters you specify (Name, Property, Role, etc.). 



 

© 1999-2009 Apelon, Inc.  All Rights Reserved. 

               Page 22 of 147 

DTS Editor Keyboard Options 
Press the Enter key to perform the default action (e.g., Apply, Close, OK, etc.) in any 
panel or popup window.  Press the Esc key to close any displayed popup window. 

View Concept Tree – Tree Tab 
The DTS Editor Concept Tree panel lists concepts in a “tree” format for easy viewing.  
As mentioned earlier, the Concept Tree panel displays in the left pane when the DTS 
Editor Main window first opens, or when you click the Tree tab.  Top-level concepts 
(“nodes”) in the hierarchy display in a collapsed view (note: if this is an association tree, 
no nodes display until you configure the tree).   

Note the top-level concepts illustrated.   

 
You can expand or collapse segments of the tree to display only those elements you want. 
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Concept Tree Panel Display Preferences 

Ontylog Tree Preferences 
The Concept Tree panel makes concepts and their relationships easier to view and 
comprehend.  The following discussions explain how to format the display of data for an 
Ontylog tree in the Concept Tree panel.  Right-click on the white space in the Concept 
Tree panel to display the following popup menu for an Ontylog tree.  

 
Any changes you make to the Concept Tree panel display settings are retained if you 
disconnect from the current session (File>Disconnect) or exit the DTS Editor 
(File>Exit).   

Classic View 
Select Classic View from the popup menu to display concepts with single or multiple 
parents in the concept tree.  
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Container View 
Select Container View from the popup menu to list concept attributes within individual, 
separate “folders.”  

 
You can open each “folder” and display the attribute values within. 
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Inline View 
The inline view lists all of the concept attributes that the Container View does, but 
without the use of “folders.” 

 

Icons and Colors 
The following icons indicate concept or term attributes in the DTS Editor.  These icons 
and colors are defined in advance for you (you cannot modify them).    

Symbol/ color     Description 

 Indicates a concept in the Concept/Term Details panel. 

 Indicates a term in the Concept/Term Details panel. 

 
Indicates a concept in the Concept Tree panel.  In the Concept/Term Details panel, 
indicates a subconcept of the concept displayed in the detailed view. 

 
In the Concept/Term Details panel, indicates a superconcept of the concept 
displayed in the detailed view. 

 In the Concept Tree and Concept/Term Details panels, indicates a synonym for a 
concept. 

 
In the Concept Tree and Concept/Term Details panels, indicates a property (such 
as print name, medical code, etc.) for a concept. 

 In the Concept Tree and Concept/Term Details panels, indicates the role that 
relates one concept to another. 

 In the Concept Tree panel, indicates the non-editable values concept Code, 
concept ID, and Namespace. 

 In the Concept Tree and Concept/Term Details panels, indicates an association 
between one concept and another. 

 In the Concept Tree and Concept/Term Details panels, indicates an association or 
property qualifier for a concept. 

 In the Concept Tree panel, indicates that the concept in the detailed view is 
included in the subset that is listed.  
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Concept Name and Attribute Text Wrapping 
If lengthy concept names and/or attribute text extend beyond the border of the Concept 
Tree panel, the text will wrap around to a new line.  The concept name or attribute text 
also will be enclosed in brackets. 

 
 

If you enlarge the Concept Tree panel, the panel size setting is retained if you disconnect 
from the DTS Server, then reconnect.  During the next session, the text wrapping and 
brackets will be removed if they are not required in the larger panel. 

 

Wrapped Concept Name Enclosed in Brackets 

     Wrapped   
     Concept  
     Attributes  
     in Brackets 

Text Wrap and 
Brackets are 
Retained Only  
if Required 
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Click to Edit (Ontylog or Thesaurus Tree) 
The Click to Edit option is available for either an Ontylog or a Thesaurus tree (only  
Click to Edit displays for a Thesaurus tree).  If you click Click to Edit, any concept you 
select displays automatically in the Concept/Term Details panel.  This eliminates the 
need to drag the selected concept to the Concept/Term Details panel for view. 

 

Multiple Panel Instances 
The DTS Editor allows you to open multiple occurrences of the Concept Tree, Concept 
Walker, and Search panels by selecting these options from the Tools menu, by clicking 
the appropriate tab, or by clicking the corresponding icon in the toolbar.  Each instance of 
the panel displays as a free-floating, sizable window; the size and location of these 
floating panels are retained for future sessions.   

You can view, compare, and drag information from multiple instances of each window. 
The data in each instance of the window can be from the same namespace, or can reflect 
data from different namespaces.  Drag and drop capability between the DTS Editor 
windows and panels lets you create associations between namespaces, and view the 
results immediately on the Concept Tree panel (refer to the Map Concepts or Terms 
across Namespaces discussion later in the guide).     

In the following illustration, two occurrences of the Concept Tree window are open 
(covering the left panel) each reflecting a different namespace. 
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In the next illustration, the Concept Tree panel displays in the left pane, and multiple 
Concept Tree floating windows display elsewhere on the DTS Main window.  Note that 
the active window is sized larger to accommodate the length of the concept names. 

 

Customize the Tree View 
Follow these procedures to select the namespace for which you want to view data.  The 
format of the concept tree display depends in part on the type of namespace you select, 
Ontylog or Thesaurus.  Based on the view parameters, you configure the tree to display 
in either a hierarchal format (subconcepts/superconcepts) or an association format that 
reflects concepts associated with a specific focus concept.  You can expand and collapse 
the tree in either format, as needed.   

Hierarchy Tree View 
Select the namespace for which the concept tree will display from the Namespace 
dropdown field list.  Click the dropdown arrow to display all namespaces available for 
view options. 

When you select an Ontylog namespace for view, the default in the View Axis dropdown 
field is Superconcepts/Subconcepts, which results in a hierarchal view of the namespace 
concepts. 
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To expand a selection to view lower-level nodes, click adjacent the Expand button  .  
When expanded, the concepts are listed in a hierarchical scheme, or “taxonomy.”  
 

 
 
In the example, when you expand Absorption, five “children” are visible.  If there is no 
Expand button adjacent to a concept, it indicates there are no additional subconcepts 
hidden for the concept.  The nodes immediately above a concept are called direct 
superconcepts (parents).  Nodes immediately below a concept are called direct 
subconcepts (children).  
 
As you expand the tree, you may want to collapse the tree to view only the higher levels 
of the hierarchy.  Click the collapse button  to hide the subconcepts. 

Association Tree View 
Select the namespace for which the concept tree will display from the Namespace 
dropdown field list.  Click the dropdown arrow to display all namespaces available for 
view options. 

When you select an Ontylog namespace for view, the default in the View Axis dropdown 
field is Superconcepts/Subconcepts, which results in a hierarchal view of the namespace 
concepts.  If you wish, you can configure a tree view that consists of all concepts for 
which associations are established for a specified concept.  An association is a 
relationship between concepts and/or terms within a namespace, or across namespaces. 

The default association type for an association tree configuration is Parent of.   
Note the illustration. 
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The association tree that displays in the Concept Tree panel reflects the default 
association type. 
 

 
 
You have the option of selecting another association type on which to base the tree view.  
Click the arrow on the View Axis field to list all existing concept associations in the 
knowledgebase.  Click the desired association to select it; the namespace in which the 
association was created displays in parentheses. 

You also have the option of establishing a focus concept in your association tree.  The 
focus concept serves as the root concept in your tree view. 
  
Drag a concept from another panel or window (e.g., Concept /Term Details panel) and 
drop it into the Focus Concept field.  The focus concept sets the starting point (i.e., root, 
or threshold) for the chain of associations to be displayed. 
 

 
To view concepts with associations to those listed in the displayed association tree, click 
the Expand button  next to the desired concept in the tree.  Note the illustration.  
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View Concepts in a Selected Namespace Subset 
A subset is a segment of concepts that you can create from a designated namespace, 
based on selection criteria that you define.  You can create a subset from a subscription or  
local namespace, or from a (classified) extension namespace. 

The concepts in each subset can share associated attributes, and each subset may include 
a few concepts or many concepts.  Refer to the DTS Subset Editor Users Guide for 
procedures on subset creation in DTS.   

If the namespace in the view has one or more subsets created for it, you can choose to 
highlight each concept in the Tree view that was selected for a subset.  The Subset field 
dropdown lists all existing subsets for (only) the namespace in the view; the subsets 
display in gold color. 

 
 
Click the desired subset in the list.  Each namespace concept that is included in that 
subset is highlighted (in gold color) in the hierarchy tree in the Concept Tree panel. 

Concepts Included in Subset of  
the Namespace in Tree View 
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For an Ontylog namespace, you also can view the concept hierarchy within each of its  
subsets.  From the View Axis field dropdown list, select Subset Hierarchy (Subset 
Hierarchy is enabled as a selection only when a namespace that has existing subsets is in 
the view).  From the Subset field dropdown list, select the subset for which you want to 
view a concept hierarchy. 

The hierarchy tree for the subset (only) displays, also in gold color. 

 
Click the Expand  and collapse  buttons to view and hide subconcepts, as needed. 
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Concept Walker View 
The Concept Walker provides a view of a selected concept’s place in the Concept Tree, 
and its relationships with other concepts.  You can configure the view to reflect either a 
hierarchal format (subconcepts/superconcepts) or an association format that reflects 
concepts associated with a specific focus concept.     

Hierarchy View 
Follow this procedure to display and use the Concept Walker panel to provide a view of 
the selected concept’s relationships (i.e., ancestor and descendant concepts).   

1. Click the Walker tab in the upper-left portion of the DTS Editor Main window.  
The Concept Walker panel displays in the left pane. 
 

 
 
The dropdown field in the center of the panel (Focus Concept) is where you select 
the concept for which relationships will be listed.  If you used the Concept Walker 
earlier in the current session, previous focus concepts are retained in the Focus 
Concept field pulldown list for your selection.     

Concept in View 

Child Section 
(subconcepts) 

Parent Section  
(superconcepts) 
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2. You can drag any concept visible on another window or panel (Search panel, 
Concept/Term Details panel, etc.) to the Focus Concept field on the Concept 
Walker panel.  For example, click the Search tab to display the Search panel, or 
click the Search icon in the toolbar to display the floating Search window; you 
can position the floating window so that it is adjacent to the Concept Walker 
panel. 
 
Drag a concept to the Focus Concept field.  When the field changes to yellow, 
unclick the mouse to drop the concept.   

3. When you select a focus concept from an Ontylog namespace for view, the 
default in the View Axis dropdown field is Superconcepts/Subconcepts, which 
results in a hierarchal view of the namespace concepts.  Do not modify this field if 
you want a hierarchal format for the view.  

4. If the focus concept you selected is from an Ontylog namespace, the name of that 
Ontylog namespace displays in the Namespace field.   If any Ontylog Extension 
namespaces exist for that namespace, these will be listed in the Namespace field 
dropdown list.   
 
An Ontylog Extension namespace is an extension of a specifically linked Ontylog 
Subscription namespace.  You create an Ontylog Extension namespace to create 
and maintain new local content for the linked Ontylog subscription namespace.  
From the list, select the Ontylog Extension namespace for which you want to 
display a hierarchy view.  Refer to the Concept Walker View and Ontylog 
Extension Namespaces discussions in the Ontylog Extension Namespaces and 
Extension Namespace Classification in DTS document for more on using the 
Concept Walker with Ontylog Extension namespaces. 

5. If your Focus Concept has one or more parents, these display in the Parent 
section above the Focus Concept dropdown field.  The section below the Focus 
Concept dropdown field displays the subconcepts, or children, of the concept. 

6. In the Parents section, you can expand any visible ancestor concept to list its 
parent concepts.  Click the Expand button .  Higher-level concepts are listed in 
inverse order to their place in the hierarchy tree.   
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7. In the Subconcepts section, click the Expand button  to expand the hierarchy 

and list children for any visible descendant of the concept you selected.  The 
focus concept is the root for this part of the view. 
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Association View 
You can configure a Concept Walker view that consists of all concepts for which 
associations are established for a specified concept.  Each association is a relationship 
between concepts and/or terms within a namespace, or across namespaces. 

Follow this procedure to display and use the Concept Walker panel to provide a view of 
associations for the selected concept. 

1. Click the Walker tab in the upper-left portion of the DTS Editor Main window.  
The Concept Walker panel displays in the left pane. 
 
The dropdown field in the center of the panel (Focus Concept) is where you select 
the concept for which relationships will be listed.  If you used the Concept Walker 
earlier in the current session, previous focus concepts are retained in the Focus 
Concept field pulldown list for your selection.  

2. You can drag any concept visible on another window or panel (Search panel, 
Concept/Term Details panel, etc.) to the Focus Concept field on the Concept 
Walker panel.  For example, click the Search tab to display the Search panel, or 
click the Search icon in the toolbar to display the floating Search window; you 
can position the floating window so that it is adjacent to the Concept Walker 
panel. 

3. Drag a concept to the Focus Concept field.  When the field changes to yellow, 
unclick the mouse to drop the concept.  The focus concept will serve as the root 
concept in your association view. 

4. When you select a focus concept from an Ontylog namespace for view, the 
default in the View Axis dropdown field is Superconcepts/Subconcepts, which 
results in a hierarchal view of namespace concepts.  Click the arrow on the View 
Axis field to list all existing concept associations within all the namespaces in 
your knowledgebase.   
 

 
 
Click the desired association to select it (the namespace in which the association 
was created displays in parentheses).  The concept(s) for which there are 
associations with the Focus Concept are listed in the Concept Walker panel.  In 
the following illustration for the focus concept Cleansers, Dentures, the concepts 
associated through the association Parent Of are listed.     
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You can drag the returned concept to the Concept/Term Details panel to view 
attribute details. 

View Subset Concepts in the Concept Walker 
If the Focus Concept field concept is from a subscription, local, or (classified) extension 
namespace for which a subset exists, you can choose to highlight in the displayed 
hierarchy those concepts within that subset.  From the Subset field dropdown (which lists 
all subsets for the Focus Concept namespace field, in gold text) select the desired subset.   

The Namespace field reflects the namespace from which the subset concepts were 
derived.  Each concept from the focus concept Namespace that is listed in the Parents 
and Subconcepts hierarchies is highlighted (in gold color). 

 

Concepts Included in Subset of  
Focus Concept Namespace 
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If the focus concept is from an Ontylog namespace, you also can view a select portion of 
the concept hierarchy for each of the Ontylog namespace’s subsets.  From the View Axis 
field dropdown list, select Subset Hierarchy (Subset Hierarchy is enabled as a 
selection only when the concept in the Focus Concept field is from a subset namespace).   

From the Subset field dropdown list, select the subset for which you want to view a 
portion of the concept hierarchy. 

The hierarchy tree for the subset (only) displays, also in gold color. 

 
Click the Expand  and collapse  buttons to view and hide subconcepts, as needed. 

Concept Name and Attribute Text Wrapping 
If a lengthy concept name text extends beyond the border of the Concept Walker panel, 
the text display in the Parent and Child sections will wrap around to a new line.  The 
concept name text also will be enclosed in brackets. 

 

Wrapped Concept 
Name Enclosed in 
Brackets 
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If you enlarge the Concept Walker panel, then drag a different concept into the Focus 
Concept field, any text wrapping and brackets will be removed if they are not required in 
the larger panel. 

 
 

Text Wrap and 
Brackets are 
Retained Only  
if Required 
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Concept Search 
Use the DTS Editor Search tab panel search features to search a selected namespace, or 
all namespaces, and retrieve specific concepts, concept terms, or concepts and synonyms 
that match the search criteria you specify.  You then can drag and drop any retrieved 
concept/term into another view panel (e.g., Concept/Term Details) for further review, or 
onto one of the Editor windows (e.g., Synonym Editor, Property Editor).  You can 
display the Search panel as a floating window; this option is available from the toolbar on 
the DTS Editor Main window menu bar, as well as from the Tools menu (Tools>Search).  

Search a selected namespace, all namespaces, or a selected namespace subset based on 
any of the following criteria: 

• Name 

• Synonym  

• Property 

• Role 

• Inverse Role 

• Concept Association 

• Inverse Concept Association 

You also can search within a specific knowledgebase silo, choosing the level of 
“exactness” by which the search in the silo will be conducted. 

To display the Search panel, click the Search tab on the DTS Editor Main window. 
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Follow this procedure to search the namespace based on the criteria you specify. 

1. Assure that the Search tab is selected and the search criteria fields display. 

2. To search for both concepts and synonyms that match your search criteria, 
Concepts & Synonyms applies.  To search for matching concepts only, click 
Concepts.  To search for matching terms only, click Terms. 

3. From the Maximum Results field dropdown list, select the maximum number of 
concepts and/or terms to be retrieved from the namespace search.  You can 
specify that the search be completed as soon as 10, 50, 100, or 250 concepts 
and/or terms that match the search criteria have been retrieved (10 is the default).   
 
You also can select Enter a Number, then specify your own maximum, up to 
9999, in the field that displays.  If you anticipate numerous results from the 
search, you should select Enter a number, then specify a large value.  Note that 
if you selected Concepts & Synonyms as a Search parameter, concept matches 
will be returned first, followed by synonym matches.  If the number of concept 
matches exceeds the Maximum Results limit, no synonym matches are returned.  
 
If you select Enter a Number, you must specify a number to perform the search.   
 
Retrieved concepts or terms display in the Search Results area in the lower 
portion of the tab.  The total number of matched items retrieved is listed as well. 
Note that a search with a larger Maximum Results number requires a longer period 
of time to complete. 

4. In the Search For field, specify the value (i.e., search string) for which you want 
to search the namespace for a match.  Specify the search string value in one of 
these manners: 

• Enter the specific search string in its entirety (e.g., abdomen endoscopy). 

• Broaden the search criteria by entering the asterisk (*) wildcard character.  
Note these examples when Name is the Search By parameter: 

o To retrieve all concept/term names containing the string abdomen, type 
*abdomen* as the search string in the Search For field. 

o To retrieve only concept/term names that begin with the string abdomen, type 
abdomen* as the search string in the Search For field. 

o To retrieve concept/term names that end with the string abdomen, type  
*abdomen as the search string in the Search For field. 
 

5. In the Search In area of the panel, click the option that reflects where you want to 
perform the search (Namespace, Subset, or Silo).  If you select Namespace, the 
accompanying dropdown lists all namespaces in your DTS knowledgebase.   
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Click the namespace in which you want to perform the search.  The default, All, 
applies if you want to search in all existing namespaces.  Note that if you select an 
Ontylog Extension namespace to search, the results will be from the Extension 
namespace only (no concepts from the linked Ontylog subscription namespace 
will be returned).  Refer to the Ontylog Extension Namespaces and Extension 
Namespace Classification in DTS document for more on Extension namespaces. 
 
If you select a Subset in which to search, the accompanying dropdown lists all 
subsets that were created for namespaces in your DTS knowledgebase. 
 

 
 
Click the subset in which you want to perform the search.     
 
Each silo in DTS is a repository of customized concept terminology data acquired 
from your knowledgebase, and optimized for searching.  If you select a Silo in 
which to search, the accompanying dropdown lists all namespace silos that were 
created in your DTS knowledgebase.  Click the desired silo in which you want to 
perform the search.    

6. In the Search By field, select the parameter that will be searched in the 
namespace(s) or subset for the string you specified in the Search For field.  Only 
the Name option is available on searches for concepts & synonyms, and searches 
for terms only.   
 
For concept searches the following options are available: 

• Name - This search will retrieve each concept (or each term, if you are 
performing a term search) with a name that matches the search string 
parameter you specified in the Search For field. 

• Synonym - This search will retrieve each concept with a synonym that 
matches the search string parameter you specified in the Search For field. 

• Property - This search will retrieve each concept with a property value that 
matches the search string parameter you specified in the Search For field, for 
the property or properties you select.   
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If you select Property as the search parameter, a list of current 
knowledgebase properties displays in the Search On list area; you select the 
properties to be searched from this list. 

o Word Match - A more generalized property search, in which you can 
specify one or more words or numbers as the Search For value, and 
the property must contain all of those search string words, in any 
order.   

• Role - This search will retrieve each concept with a role value (i.e., target 
concept name) that matches the search string parameter you specified in the 
Search For field, for the role type(s) you select (e.g., Procedure site).  If you 
select Role as the search parameter, a list of current role types displays in the 
Search On list area; you select the role type(s) to be searched from this list. 

• Inverse Role - This search will retrieve each concept with an inverse role 
value that matches the search string parameter you specified in the Search For 
field, for the inverse role type(s) you select (e.g., Procedure site).  If you 
select Inverse Role as the search parameter, a list of current inverse role 
type(s) displays in the Search On list area; you select the inverse roles to be 
searched from this list. 

• Concept Association - This search will retrieve each concept that has an 
association target concept with a name that matches the search string 
parameter you specified in the Search For field, for the association(s) you 
select (e.g., Is A Parent Of).  If you select Concept Association as the search 
parameter, a list of current association type(s) displays in the Search On list 
area; you select the association type(s) to be searched from this list. 

• Inverse Concept Association - This search will retrieve each concept that has 
an inverse association from concept with a name that matches the search 
string parameter you specified in the Search For field, for the inverse 
association(s) you select (e.g., Is A Parent Of).  If you select Inverse 
Concept Association as the search parameter, a list of current inverse 
association types displays in the Search On list area; you select inverse 
association type(s) to be searched from this list. 

7. After you specify all search criteria, click Search. The retrieved concepts and/or 
terms are listed in the Search Results area in the lower portion of the tab. The total 
number of retrieved matched concepts or terms is indicated as well (Matches 
Found:).  When you find the desired concept(s), you can drag the concept(s) to 
the Concept Walker or Concept/Term Details panel to view details.   
 
Note that after you click Search to begin the search, the button changes to 
Cancel; to terminate a long-running search, click Cancel and enter alternate 
search criteria.  The button changes back to Search when the search is completed.   
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Search for Concepts or Terms Based On Name 
Follow this procedure to search for concepts or terms based on name.  

1. Concepts & Synonyms applies if you want to search for both concepts and 
synonymous terms.  To search for matching concepts only, click Concepts.  To 
search for matching terms only, click Terms. 

2. Specify the name (i.e., search string) of the concept/term for which you are 
searching in the Search For field.   

3. In the Search In area, click the option (Namespace, Subset, or Silo) that indicates 
where you want to search, then from the accompanying dropdown list, select the 
specific namespace, subset, or silo to search.    

4. For namespace and subset searches, select Name in the Search By field as the 
search parameter for the string you specified in the Search For field. 

5. Click Search. Concept/Term names matching the search string parameter you 
specified in the Search For field display in the Search Results area in the lower 
portion of the panel.  Note the matched concepts retrieved from a namespace 
search for the concept name search string *amino*; each returned concept 
references the namespace from which it was retrieved. 
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Search for Concepts With Selected Synonyms 
Follow this procedure to search for concepts that have one or more selected synonyms 
that match the search string.  

1. Click Concepts as your Search option.   

2. In the Search For field, specify the synonym search string. 

3. In the Search In area, click the option (Namespace, Subset, or Silo) that indicates 
where you want to search, then from the accompanying dropdown list, select the 
specific namespace, subset, or silo to search. 

4. For namespace and subset searches, in the Search By field select Synonym as the 
search parameter for the string you specified in the Search For field.  A list of 
current association types (each representing an association between a concept and 
a synonymous term) displays in the Search On list area. 
 
Concepts with synonyms that match the search string you entered will be 
returned, provided the returned terms also meet the other search parameters you 
specify.  A synonym is a term associated with a concept by an association type 
that represents a concept-to-term association; a synonym always is defined 
between a concept and a term (however, two terms can be synonyms of the same 
concept).   

5. The Type Namespace field displays if you selected Synonym as the search 
parameter in the Search By field.  The default is to search All namespaces for 
synonyms that match the other search criteria.  The Type Namespace field gives 
you the option of filtering the synonym search further.   
 
You can restrict returned results to those synonyms for which associations 
(concept to term type) were established with the search string term.  From the 
Type Namespace field dropdown list, select the namespace in which the synonym 
association must exist in order to be included in the search results. 

6. From the Search On field list, select one or more concept-to-synonymous term 
association types for which to conduct the search.   

• To select two or more nonadjacent association types, click the name of one 
association type, then hold down Ctrl and click the name of each additional 
association type.  Each association type you select is highlighted. 

• To select adjacent association types, click the name of the first association 
type in the list, then hold down Shift and click the name of the last association 
type in the list. All the association types between the first and last are 
highlighted. 
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For the selected concept-to-synonymous term association types, only concepts 
with synonyms that match the specified search string will be matched and 
retrieved.  In the illustration, the search string *stomach* was specified. 
 

 
7. Click Search. Concepts with the selected association types with synonymous 

term name values that contain the search string you specified in the Search For 
field, display in the Search Results area in the lower portion of the panel.  Note 
the matched concepts retrieved when the selected association type in the specified 
namespace is Synonym, and the search string is *stomach*.  Each returned 
concept references the namespace from which it was retrieved. 
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Search for Concepts With Selected Properties 
Follow this procedure to search for concepts that have one or more selected properties 
with values that match the search string.  

1. Click Concepts as your Search option.   

2. In the Search For field, specify the property search string.   

3. In the Search In area, click the option (Namespace, Subset, or Silo) that indicates 
where you want to search, then from the accompanying dropdown list, select the 
specific namespace, subset, or silo to search. 

4. For namespace and subset searches, in the Search By field select Property as the 
search parameter for the string you specified in the Search For field.  A list of 
current property types displays in the Search On list area. 

5. From the Search On field list, select one or more property types for which to 
conduct the search.   

• To select two or more nonadjacent property types, click the name of one 
property type, then hold down Ctrl and click the name of each additional 
property type. Each property type you select is highlighted. 

• To select adjacent property types, click the name of the first property type in 
the list, then hold down Shift and click the name of the last property type in 
the list. All the property types between the first and last are highlighted. 

For the selected property types, only concepts with property values that match the 
search string you specified will be matched and retrieved from the search.  In the 
illustration, the property type Reviewed By [NDF-RT] was selected.  
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6. Click Search. Concepts with the selected property type(s), with values that 
contain the search string you specified in the Search For field, display in the 
Search Results area in the lower portion of the panel. 
   
Note the matched concepts retrieved when the selected property type is Reviewed 
By [NDF-RT], and the search string is *pharmacologic*; each returned concept 
references the namespace from which it was retrieved. 
 

 

Search for Concepts Using the Word Match Feature 
The word match search feature works in conjunction with the property search.  It allows 
you to search for a concept based on property when you may not know the property’s 
exact (search string) value. If you specify as the search string those words you believe 
apply to the property value, the DTS Editor search will retrieve all concepts that contain 
those words, in any arrangement, as part of the selected property type(s). 

The word match search restricts the search to only those concepts with property types that 
have the CONTAINS INDEX column marked T (true) in the setContains.sql file 
(DTSInstall\ scripts\Oracle).  Refer to the Configure Word Match Search discussion in 
the Knowledgebase Administrators Guide for configuration instructions – note that the 
Knowledgebase Administrator must run the Knowledgebase Admin utility in order for 
the word match search feature to be implemented.  
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Follow this procedure to search for concepts using the word match feature: 

1. Specify the search string in the Search For field.  For the property word match 
search, you can specify two or more words. The search results will be those 
concepts for which all of the specified search string words are included in the 
property value (in any order) for the selected property types. 
 
Note: When doing a word match search, you cannot perform a “search all” 
wildcard search (i.e., you cannot enter a “*” in the Search For field).  There must 
be at least one other letter on which to base the word match search. 

2. In the Search In area, click the option (Namespace, Subset, or Silo) that indicates 
where you want to search, then from the accompanying dropdown list, select the 
specific namespace, subset, or silo to search. 

3. For namespace and subset searches, in the Search By field select Property as the 
search parameter for the string you specified in the Search For field.  A list of 
current property types displays in the Search On list area. 

4. From the Search On field list, select one or more property types for which to 
conduct the search.  In the example, property type NDF_Trade_Name [NDF-
RT] is selected.  
 

 
5. Click the Word Match field checkbox to select the word match search parameter. 

6. Click Search.  Concepts with the selected property type(s), with values that 
contain the specified search string words (in any order) specified in the Search 
For field, display in the Search Results area in the lower portion of the panel.  
Note the matched concepts retrieved when the word match option is selected, the 
selected property type is NDF_Trade_Name [NDF-RT], and the search string is 
*NEW FORMULA*; each returned concept references the namespace from 
which it was retrieved. 
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Only the concepts for which the selected property type (NDF_Trade_Name 
[NDF-RT]) value includes both the words NEW and FORMULA were 
retrieved.  

Search For Concepts With Selected Roles 
Follow this procedure to search for concepts that have one or more selected role types.  

1. Click Concepts as your Search option.   

2. In the Search For field, specify the search string for concept role values.   

3. In the Search In area, click the option (Namespace, Subset, or Silo) that indicates 
where you want to search, then from the accompanying dropdown list, select the 
specific namespace, subset, or silo to search. 

4. For namespace and subset searches, in the Search By field select Role as the 
search parameter for the role type value string parameter you specified in the 
Search For field.  A list of current role types displays in the Search On list area. 

5. From the Search On field list, select one or more role types for which to conduct 
the search.   

• To select two or more nonadjacent role types, click the name of one role type, 
then hold down Ctrl and click the name of each additional role type. Each 
role type you select is highlighted. 
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• To select adjacent role types, click the name of the first role type in the list, 
then hold down Shift and click the name of the last role type in the list. All the 
role types between the first and last are highlighted. 

Only concepts with role type values that contain the search string you specified, 
for the selected role types, will be matched and retrieved from the search.  In the 
example, the role type CI_with [NDF-RT] was selected.  
 

 
6. Click Search. Concepts that have the selected role type, with values that contain 

the search string you specified in the Search For field, display in the Search 
Results area in the lower portion of the panel.  Note the matched concepts 
retrieved when the selected role type is CI_with [NDF-RT], and the search string 
is *bone*; each returned concept references the namespace from which it was 
retrieved. 
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Search for Concepts With Selected Inverse Roles 
Follow this procedure to search for concepts that have one or more selected inverse role 
types.  

1. Click Concepts as your Search option.   

2. In the Search For field, specify the search string for concept inverse role values.   

3. In the Search In area, click the option (Namespace, Subset, or Silo) that indicates 
where you want to search, then from the accompanying dropdown list, select the 
specific namespace, subset, or silo to search. 

4. For namespace and subset searches, in the Search By field select Inverse Role as 
the search parameter for the inverse role value string parameter you specified in 
the Search For field.  A list of current role types displays in the Search On list 
area. 

5. From the Search On field list, select one or more role types for which to conduct 
the search.   

• To select two or more nonadjacent role types, click the name of one role type, 
then hold down Ctrl and click the name of each additional role type. Each 
role type you select is highlighted. 

• To select adjacent role types, click the name of the first role type in the list, 
then hold down Shift and click the name of the last role type in the list. All the 
role types between the first and last are highlighted. 

Only concepts with inverse role values that contain the search string you 
specified, for the selected role types, will be matched and retrieved from the 
search.  In the example, the role type CI_with [NDF-RT] was selected. 
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6. Click Search. Concepts that have the selected inverse role type, with values that 
contain the search string you specified in the Search For field, display in the 
Search Results area in the lower portion of the panel.  Note the matched concept 
retrieved when the selected role type is CI_with [NDF-RT], and the search string 
is *POTASSIUM IODIDE*; the returned concept references the namespace 
from which it was retrieved. 
 

 

Search for Concepts With Selected Concept Associations 
Follow this procedure to search for concepts that have one or more selected associations.  

1. Click Concepts as your Search option.   

2. In the Search For field, specify the search string for the name of the target 
concept in the concept association.   

3. In the Search In area, click the option (Namespace, Subset, or Silo) that indicates 
where you want to search, then from the accompanying dropdown list, select the 
specific namespace, subset, or silo to search. 

4. For namespace and subset searches, in the Search By field select Concept 
Association as the search parameter for the name of the target concept in the 
concept association (i.e., the string you specified in the Search For field).  A list 
of current association types displays in the Search On list area. 

5. The Type Namespace field displays if you selected Concept Association as the 
search parameter in the Search By field.  The default is to search All namespaces 
for association types that match the other search criteria.  The Type Namespace 
field gives you the option of filtering the search further.  From the Type 
Namespace field dropdown list, select the namespace in which the association 
type must exist in order to be included as a Search On selection option. 
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6. From the Search On field list, select one or more association types for which to 
conduct the search.   

• To select two or more nonadjacent association types, click the name of one 
association type, then hold down Ctrl and click the name of each additional 
association type. Each association type you select is highlighted. 

• To select adjacent association types, click the name of the first association 
type in the list, then hold down Shift and click the name of the last association 
type in the list. All the association types between the first and last are 
highlighted. 

Only concepts that have concept associations with target concept names that 
contain the search string you specified, for the selected association type(s), will be 
matched and retrieved from the search.  In the example, the association type 
Related To [AOD [Alcohol and Other Drug Thesaurus ]] was selected.  
 

 
7. Click Search.  Concepts that have the selected association type in the namespace 

you designated, that have concept associations with target concept names that 
contain the search string you specified in the Search For field, display in the 
Search Results area in the lower portion of the panel.   
 
Note the matched concepts retrieved when the selected association type is 
Related To [AOD [Alcohol and Other Drug Thesaurus ]], and the search string 
is *alcohol*; each returned concept references the namespace from which it was 
retrieved. 
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Search for Concepts With Selected Inverse Concept Associations 
Follow this procedure to search for concepts with the selected inverse association types.  

1. Click Concepts as your Search option.   

2. In the Search For field, specify the search string for the name of the from concept 
in the concept association.   

3. In the Search In area, click the option (Namespace, Subset, or Silo) that indicates 
where you want to search, then from the accompanying dropdown list, select the 
specific namespace, subset, or silo to search. 

4. For namespace and subset searches, in the Search By field select Inverse 
Concept Association as the search parameter for the from concept name string 
specified in the Search For field.  A list of current association types displays in 
the Search On list area. 

5. The Type Namespace field displays if you selected Inverse Concept Association 
as the search parameter in the Search By field.  From the Type Namespace field 
dropdown list, select the namespace in which the association type must exist in 
order to be included as a Search On selection option. 

6. From the Search On field list, select one or more association types for which to 
conduct the search.   

• To select two or more nonadjacent association types, click the name of one 
association type, then hold down Ctrl and click the name of each additional 
association type. Each association type you select is highlighted. 
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• To select adjacent association types, click the name of the first association 
type in the list, then hold down Shift and click the last association type in the 
list.  All the association types between the first and last are highlighted. 

Only concepts that have concept associations with from concept names that 
contain the search string you specified, for the selected association type(s), will be 
matched and retrieved from the search.  In the example, the association type 
Parent Of [AOD [Alcohol and Other Drug Thesaurus ]] was selected. 
 

 
7. Click Search.  Concepts that have the selected association type, in the namespace 

you designated, with associations that have from concept names that contain the 
search string you specified in the Search For field, display in the Search Results 
area in the lower portion of the panel.   
 
Note the matched concepts retrieved when the selected association type is Parent 
Of [AOD [Alcohol and Other Drug Thesaurus ]], and the search string is 
*fetal*; each returned concept references the namespace from which it was 
retrieved. 
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Search for Concepts in a Knowledgebase “Silo” 
Follow this procedure to search for concepts that contain the specified search string, and 
that also reside within a specific knowledgebase silo.  Each silo is a generated repository 
of customized concept terminology data acquired from your knowledgebase, and 
optimized for searching.   

Included with Apelon DTS are the components you can use to generate and populate silos 
with customized knowledgebase data.  Refer to the DTS Knowledgebase Administrators 
Guide for procedures on customizing the silos with data from your knowledgebase.  

Follow this procedure to search for concepts within the knowledgebase silo(s) you select. 

1. Click Concepts as your Search option.   

2. In the Search For field, specify the concept/term search string.   

3. In the Search In area, select Silo to indicate where you want to search for the 
string you specified in the Search For field.  If your DTS knowledgebase 
administrator ran the DTS Selector & Extractor utility to create knowledgebase 
silos, these generated silos are listed.  Select the specific database silo in which to 
search; only the selected silo will be searched for the string you specified.   
 
Depending on the configuration for populating the silos, each silo may contain 
data from multiple namespaces, or from a single namespace.  Note that the 
Namespace dropdown field is not available when you perform a silo search (this 
is because the silo configuration determines which namespaces will be searched). 



 

© 1999-2009 Apelon, Inc.  All Rights Reserved. 

               Page 58 of 147 

4. At this point you can choose from a series of search features that allow you to 
specify the level of “exactness” for the search of the selected silo.  These are 
referred to as the MatchPack matching options.   
 

 
 
The Match Type allows you to choose from three increasingly tolerant types of 
search matching.  Matches are attempted in the order shown in the following 
discussions. 

A. Complete Match: This is the most exact method of matching the search string 
that you specify to either a concept name, or the name of one of its synonyms, , in 
the silo you selected.  Complete Match is always active (even if you choose one 
of the other, more tolerant, matching methods).    

• Through Complete Match, a match occurs and a concept is retrieved when 
either the concept name, or the name of one of its synonyms, in the silo 
contains the same words as the search string you specify, in any order.   

• Every concept in the silo that has a name, or a synonym with a name, that 
contains all the words in the search string (in any order) is retrieved. 

B. Under Match: If Under Match is activated, and Best Match Only also is active, 
Complete Match is performed first (i.e., if either a concept name, or the name of 
one of its synonyms, in the specified silo contains every word in the search string, 
in any order, a match occurs).  If complete matches are found, only these matches 
are returned and no further matching attempt is made.  If no concept matches 
occur from the Complete Match, Under Match is attempted.  If under matches are 
found, only these matches are returned. 

• If Under Match is activated, and Best Match Only is inactive, under 
matches will be returned in addition to the complete matches.  

• Through Under Match, a match occurs and a concept is retrieved if either 
the concept name, or the name of one of its synonyms, in the silo matches 
the search string words (in any order) and the concept term in the silo 
contains words in addition to those in the search string.   

C. Partial Under Match: If Partial Under Match (the default) is activated, and Best 
Match Only also is active, Complete Match is performed first (i.e., if either a 
concept name, or the name of one of its synonyms, in the specified silo contains 
every word in the search string, in any order, a match occurs).  If complete 
matches are found, only these matches are returned and no further matching 
attempt is made.   

• If no matches occur from Complete Match, Under Match is attempted.  If 
under matches are found, only these matches are returned.   
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If no matches occur from Under Match, Partial Under Match matches are 
attempted.   

• If Partial Under Match is activated, and Best Match Only is inactive, 
partial under matches are returned in addition to complete matches and 
under matches.  

• Through Partial Under Match, a match occurs and a concept is retrieved if 
either the concept name, or the name of one of its synonyms, in the 
specified silo contains all remaining words (in any order) after all 
stopwords have been removed.   
 
The following stopwords are those words that are considered as 
unnecessary for the search: 
 
                             A 
                                 and 
                                 by 
                                 for 
                                 in 
                                 NOS 
                                 of 
                                 on 
                                 the 
                                 to 
                                 with 

• Example: For the search string attack in the heart and brain, the string 
becomes attack heart brain because the stopwords in, the, and and are 
discarded.  If the words in the modified search string match either a 
concept name, or the name of one of its synonyms, in the silo (in any 
order) a match is returned. 

5. The Spell Checking option is another of the MatchPack options you can use to 
search the selected silo.  In the event you enter a misspelled search string word, 
spell checking generates suggested spelling variants against which matches are 
attempted; concepts matched against these variants then are retrieved.  If you 
click the Spell Checking field checkbox, spelling correction will occur when 
MatchPack attempts to match either a concept name, or the name of a concept 
synonym, with the search string you specify.   
 
You can use spell checking regardless of the matching option you select 
(Complete Match, Under Match, or Partial Under Match).  However, the 
number of matched concepts retrieved from the search is dependent on the 
matching method you select.    

6. Click Search. Concepts in the selected silo that meet the search criteria you 
specified display in the Search Results area in the lower portion of the panel.   
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Search for Concepts in a Namespace Subset 
Follow this procedure to search for concepts that contain the specified search string, and 
that also reside within a specific namespace subset.  A subset is a segment of concepts 
created from a designated namespace, based on selection criteria that you define.  Refer 
to the DTS Subset Editor Users Guide for procedures on subset creation in DTS.   

Follow this procedure to search for concepts in the namespace subset you select. 

1. Click Concepts as your Search option.   

2. In the Search For field, specify the concept/term search string.   

3. In the Search In area, select Subset to indicate where you want to search for the 
string you specified in the Search For field, then from the accompanying 
dropdown list, select the specific subset in which to search. 
 

 
4. In the Search By field, select the desired search parameter (e.g., Role, Property, 

Concept Association, etc.). 
 
Only concepts in the selected subset that match your search criteria, including the 
search string you specified, will be retrieved from the search.  In the example, the 
subset NDF-RT was selected for a concept Name search.  
 

 
5. Click Search.  Each concept in the selected subset that has a concept name that 

includes the search string you specified in the Search For field displays in the 
Search Results area in the lower portion of the panel.   
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Note the matched concepts retrieved from a concept Name search when the 
selected subset is NDF-RT, and the search string is *receptor*; each returned 
concept references the subset from which it was derived. 
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Namespace Maintenance 

Overview 
Each namespace in DTS represents an individual source terminology (e.g., SNOMED, 
ICD-9-CM).  The DTS Editor provides a set of options that allow you to view data in all 
namespaces, edit namespaces of certain types, and create new, local namespaces.     

A namespace authority indicates the organization (e.g., U.S. National Library of 
Medicine, U.S. Medical Terms Review) that approved and/or certified a specific 
terminology.  A namespace authority must be specified as part of each namespace 
definition.  In addition to namespace maintenance, authority maintenance is discussed in 
this section. 

A namespace’s locality indicates how the namespace data was acquired.  A Subscription 
namespace is one for which content was loaded into DTS through a subscription import.  
A Local namespace is one that was created using the DTS Editor, or loaded from TDE 
using the Knowledgebase Load utility, for the purpose of creating and maintaining local 
terminology content.    

In DTS a namespace is one of four distinct types: Ontylog, Thesaurus, Connection, or 
Ontylog Extension.  Each namespace type is described briefly, as well as the level of 
functionality available in each namespace type using the DTS Editor. 

Ontylog Namespaces 
Ontylog is a language used to build and maintain large knowledgebases using description 
logic.  Concepts in Ontylog are organized into a taxonomy by a process called 
classification.  An Ontylog namespace is one developed using Apelon’s Terminology 
Development Environment (TDE) suite of tools, including the Ontylog Editor.   

The DTS Editor provides view capabilities for Ontylog subscription namespaces.  In the 
DTS Editor you can view the concept hierarchy tree in any selected Ontylog terminology 
namespace.  You also can view attribute details (e.g., properties, roles) for any selected 
concept in the namespace. 

You cannot use the DTS Editor to perform edits directly to an Ontylog-type subscription 
namespace.  However, the DTS Editor allows you to create and maintain new content for 
the Ontylog subscription namespace through two different approaches. 

• You can create a new local, editable Thesaurus namespace using the DTS Editor 

o Within this local namespace you can add new properties to the Ontylog 
subscription concepts, create synonyms, create associations, and add 
qualifiers to properties and associations.   
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o Because the local content is in a separate namespace, this approach 
prevents inadvertent overwrite of any new local data (entered using the 
DTS Editor) if updated TDE content is migrated into the DTS 
knowledgebase at a later time.  Refer to the Current Local Namespace 
discussion later in this section.  

• You can create an Ontylog Extension namespace  

o As its title implies, each Ontylog Extension namespace is an extension of 
a specific Ontylog subscription namespace, created for the purpose of 
creating/maintaining new local content for the linked Ontylog subscription 
namespace. 

o In the Extension namespace you can add new concepts, add or change 
concept relationships (i.e., superconcept/subconcept relationships) add or 
change role relationship values, and add new associations for the Ontylog 
namespace. 

o You can classify the Extension namespace against the linked Ontylog 
subscription namespace, then view the new hierarchy for the Ontylog 
Extension namespace; the displayed Extension namespace hierarchy 
reflects both the linked Ontylog subscription namespace concepts, and 
concepts from the Extension namespace.   

o Refer to the Create and Maintain Ontylog Extension Namespaces and 
Classify an Ontylog Extension Namespace discussions in the Ontylog 
Extension Namespaces and Extension Namespace Classification in DTS 
document for more on Ontylog Extension namespaces and classification. 

 

 
 

Thesaurus Namespaces 
In DTS a Thesaurus namespace is one that is created as a more localized collection of 
concepts and terms.  For Thesaurus namespaces, concepts are organized based on 
relationships (associations) with other concepts. 

Subscription namespaces with the type of Thesaurus are not editable in the DTS Editor.  
However, you can create a new local namespace that is a Thesaurus type and create and 
maintain content locally.  

Connection Namespaces 
Connection namespaces do not contain any concepts or terms.  Rather, they contain 
associations between concepts or terms in other namespaces. 

Note: You also can perform maintenance on Ontylog namespaces using the TDE Ontylog 
Editor tool.  Refer to the Ontylog Editor User Guide, included with the TDE product, for 
details on maintaining Ontylog namespace data using that tool.  
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Current Local Namespace 
Select Set Current Local Namespace from the Options menu to set a current local 
namespace using the Set Current Local Namespace window.  The namespace you specify 
here becomes the default local (writable) namespace for the addition and maintenance of 
the property types, association types, and qualifier types used during the addition of local 
content to a subscription namespace. 
 

 
Thereafter, you can add a new property, synonym, or association to a concept or term in a 
subscription namespace, as long as the appropriate attribute type (e.g., property type) 
exists in the current local namespace.  You have the option of changing the local 
namespace at a later time.   

Attributes added in this manner to a concept or term in a subscription namespace are 
listed in italics in the Concept/Term Details panel view, as well as in the Concept Tree 
panel view (Container and Inline versions of the Ontylog Tree view).  Note the 
illustration.  

 
The attributes themselves actually are written to the local namespace; no database 
updates occur for the subscription namespace itself. 

You must create at least one local namespace using the DTS Editor.  The Editor allows 
you to select a current, or working local namespace in which local content for any 
subscription namespaces will be stored.  You can change the current local namespace at 
any time; the DTS Editor remembers the local namespace the next time you connect to it.  
For your reference, the current local namespace always displays in the right-most panel 
of the Status Bar at the bottom of the DTS Editor Main window. 
 
For the purpose of adding local content, you will create property types, concept or term 
association types, and qualifier types in a local namespace.  When you add properties to a 
concept, the property types do not have to reside in the same namespace as the concept, 
but can be in a local namespace.   

Subscription Content Added to Local Namespace 
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Synonymous association types and synonyms also may reside in a local namespace.  
Qualifier types may reside in the local namespace as well, and do not have to be in the 
same namespace as the properties or associations they modify. 

Since the current local namespace may be changed, it is not necessary for local content 
for a subscription namespace to be stored in a single local namespace.  Local concepts 
and terms may, of course, be created in a local namespace and associated with concepts 
and terms in the subscription namespace. 

Since properties, synonyms, and associations are attached directly to concepts in the 
subscription namespace, you can retrieve these details along with the existing 
subscription attributes of the concepts.  In the DTS Editor, when you add or modify 
properties, synonyms, associations, or qualifiers of a subscription concept, the list of 
types (e.g. property types) will be those defined in the current local namespace, rather 
than those in the subscription namespace.  When you perform a search in the DTS Editor, 
the list of relevant types offered as search options will be those types defined in the 
selected subscription or local namespace. 

Create a Local Namespace 
Follow this procedure to add a new local namespace to your knowledgebase.  Note: You 
cannot create a local namespace if you connected to the DTS Editor using a secure socket 
server connection (the New button is disabled).  You must connect to the DTS Editor 
using a JDBC connection or socket server connection in order to add a new namespace.  
Refer to the Connect to DTS Editor discussions for connection procedures. 

1. To create a new namespace, select Namespace from the DTS Editor Main window 
Tools menu.  The Namespace Editor window displays. 
 

 
2. Click New.  The fields in the lower portion of the window are enabled.  
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3. In the Name field, specify the name (i.e., title) of the namespace you are creating.  
Note that the namespace name should not include double quotes (”).  

4. In the ID field, specify the ID for your new local namespace, which can be 
between zero and 65535.  If you specify a number less than 32768, DTS adds the 
number 32768 to the ID number you specify to create an internal namespace ID.   
 
The calculated ID displays for your reference, as well as the ID number you 
entered (referred to as the relative ID).  If the calculated ID number is in use 
already, a message displays to indicate the duplication; enter an alternate ID 
number.   
 
You must specify this internal namespace ID if you want to publish this local 
namespace content for your own subscribers using the kbcontent-publish utility.  
Refer to the Publish Client’s Local Namespace discussion in the Knowledgebase 
Administrators Guide for local content publishing procedures. 

5. Specify a namespace Code for additional namespace identification; the code can 
be formatted however you want.   

6. An authority indicates the organization (e.g., U.S. National Library of 
Medicine) that approved and/or certified a terminology.  From the Authority field 
dropdown list, select the established authority for the new namespace.  Refer to 
the Authority View and Maintenance discussions for procedures on viewing and 
creating authorities. 

7. A namespace is one of four types: Ontylog, Thesaurus, Connection, or Ontylog 
Extension.  You can create Thesaurus, Connection, or Ontylog Extension 
namespaces locally and make them read-only or editable.  From the Type field 
dropdown list, select the type of terminology (Thesaurus, Connection, or 
Ontylog Extension) represented in this namespace.  Refer to the Overview 
discussions under Namespace Maintenance for more on the Thesaurus and  
Connection namespace types. 
 
You can create an Ontylog Extension namespace as an extension of an Ontylog 
subscription namespace.  In the Ontylog Extension namespace you can create 
new concepts for an Ontylog subscription namespace, then classify the Extension 
namespace against the linked Ontylog subscription namespace.   
 
Refer to the Create and Maintain Ontylog Extension Namespaces and Classify an 
Ontylog Extension Namespace discussions in the Ontylog Extension Namespaces 
and Extension Namespace Classification in DTS document for more on Ontylog 
Extension namespaces and classification. 
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8. The Linked Namespace field is enabled only if you are creating an Ontylog 
Extension namespace for an existing Ontylog subscription namespace (i.e., the 
value in the Type field is Ontylog Extension).  The field is disabled for all 
namespaces other than those of the Ontylog Extension type.  In the Namespace 
Editor window, the linked Ontylog subscription namespace is referenced in the 
Extends column.  
 
Select the Ontylog subscription namespace for which you are creating the new 
Extension namespace.  In the Extension namespace you can create and edit 
concepts for the linked Ontylog subscription namespace.  You also can classify 
concepts in the Extension namespace against the content in the Ontylog 
subscription namespace.   
 
Refer to the Create and Maintain Ontylog Extension Namespaces and Classify an 
Ontylog Extension Namespace discussions in the Ontylog Extension Namespaces 
and Extension Namespace Classification in DTS document for more on Ontylog 
Extension namespaces and classification. 

9. The namespace permission indicates whether or not the local namespace is 
editable.  From the Permission field dropdown list, select the level of permission 
(Read-Only or Read-Write) a user will have in this namespace. 

10. The namespace Locality indicates how the namespace data was acquired.  Local 
is the value for a namespace created using the DTS Editor, or loaded from TDE 
using the Knowledgebase Load utility, for the purpose of creating and 
maintaining local terminology content; the field is not editable. 

11. Click Apply to add the namespace to the knowledgebase.  The new namespace is 
added to the table on the Namespace Editor window, which remains displayed; 
you can click New again and create additional local namespaces. 

12. When you finish creating, viewing, and editing namespaces, click Close to close 
the Namespace Editor window. 



 

© 1999-2009 Apelon, Inc.  All Rights Reserved. 

               Page 68 of 147 

View and Edit an Existing Namespace 
Follow this procedure to view information for an existing subscription namespace, or 
local namespace in your knowledgebase.  For a local namespace, you can edit the 
information as necessary.  Subscription namespace information is not editable.   

1. To view or edit an existing namespace, select Namespace from the DTS Editor 
Main window Tools menu.  The Namespace Editor window displays. 
 

 
 
Information for each existing namespace is listed in a table format.  Information 
includes the namespace name and namespace type (Ontylog, Thesaurus, 
Connection, or Ontylog Extension).  An indicator referencing if each namespace 
is a local namespace (TRUE, FALSE) is included as well.  For each listed 
Ontylog Extension namespace, the name of the Ontylog subscription namespace 
to which it is linked is referenced.   
 
You can resize the table columns.  To change the sort for the namespace list, click 
the column header for the characteristic (Namespace, Type, Local, or Extends) 
on which you want to base the sort.      

2. In the table listing, click the namespace you want to view or modify to highlight 
the row.  The data in the bottom portion of the window changes to reflect 
information from that namespace.  
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The namespace Name displays.  This field is editable for a local namespace.    

3. The ID for an existing namespace is not editable, regardless of whether it is a 
subscription or local namespace.  See the Create a Local Namespace discussion 
for information on assigning a namespace ID to a new local namespace.    

4. The Code provides additional namespace identification, and can be formatted 
however you want.  The Code for an existing namespace is not editable, 
regardless of whether it is a subscription or local namespace.      

5. An authority indicates the organization (e.g., U.S. National Library of 
Medicine) that approved and/or certified a terminology.  For a local namespace, 
select an alternate, established authority from the Authority field dropdown list.  
Refer to the Authority View and Maintenance discussions for procedures on 
viewing and creating authorities. 

6. A namespace is one of four types: Ontylog, Thesaurus, Connection, or Ontylog 
Extension.  Each namespace may be a subscription namespace, or a local 
namespace.  Refer to the Overview discussions under Namespace Maintenance 
for more on namespace types. 
 
Using the DTS Editor you can create an Ontylog Extension namespace as an 
extension of an Ontylog subscription namespace.  In the Extension namespace 
you can create new concepts for an Ontylog subscription namespace, then classify 
the Extension namespace against the linked Ontylog subscription namespace.   
 
Refer to the Create and Maintain Ontylog Extension Namespaces and Classify an 
Ontylog Extension Namespace discussions in the Ontylog Extension Namespaces 
and Extension Namespace Classification in DTS document for more on Ontylog 
Extension namespaces and classification. 
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A Thesaurus namespace may be either a subscription namespace or a local 
namespace.  Using the DTS Editor you can create a new local namespace as either 
a Thesaurus or Connection namespace.  For a local namespace, select the type 
of terminology represented by this namespace from the Type field dropdown list. 

7. If you are viewing or editing information for an Ontylog Extension namespace, 
the value in the Linked Namespace field reflects the Ontylog subscription 
namespace to which it is linked.  The field is blank for namespaces other than 
those of the Ontylog Extension type.  In the Namespace Editor window, the 
linked Ontylog subscription namespace is referenced in the Extends column.   
 
Refer to the Create and Maintain Ontylog Extension Namespaces and Classify an 
Ontylog Extension Namespace discussions in the Ontylog Extension Namespaces 
and Extension Namespace Classification in DTS document for more on Ontylog 
Extension namespaces and classification. 

8. The namespace Permission indicates whether or not the namespace is writable.  
For a local namespace, select the level of permission (Read-Only or Read-
Write) in this namespace from the Permission field dropdown list.  Subscription 
namespaces are Read-Only. 

9. The namespace Locality indicates how the namespace data was acquired.  
Subscription indicates a load of namespace content into DTS through a 
subscription import.  Local indicates the namespace was created using the DTS 
Editor, or loaded from TDE using the Knowledgebase Load utility, for the 
purpose of creating and/or maintaining local terminology content.  This field is 
not editable for existing namespaces.    

10. Click Apply (which becomes enabled if you make an edit) to update any 
namespace edits.  To ignore the edits, click on any other namespace listed in the 
table to display information specific to that namespace.   

11. When you finish viewing/editing namespaces, click Close to close the Namespace 
Editor window.   



 

© 1999-2009 Apelon, Inc.  All Rights Reserved. 

               Page 71 of 147 

Delete a Local Namespace 
Follow this procedure to delete an existing local namespace from your knowledgebase 
(i.e., one that is not set as the current local namespace).  Note: You cannot delete a local 
namespace if you connected to the DTS Editor using a secure socket server connection 
(the Delete button is disabled).  You must connect to the DTS Editor using a JDBC 
connection or socket server connection in order to delete an existing local namespace.  
Refer to the Connect to DTS Editor discussions for connection procedures. 

1. To delete an existing local namespace, select Namespace from the DTS Editor 
Main window Tools menu.  The Namespace Editor window displays. 
 

 
 
Information for each existing namespace is listed in a table format.  Information 
includes the namespace name and namespace type (Ontylog, Thesaurus, 
Connection, or Ontylog Extension).  An indicator referencing if each namespace 
is a local namespace (TRUE, FALSE) is included as well.  For each listed 
Ontylog Extension namespace, the name of the Ontylog subscription namespace 
to which it is linked is referenced.   
 
To change the sort for the namespace list, click the column header for the 
characteristic (Namespace, Type, Local, or Extends) on which you want to base 
the sort.           

2. In the namespace table listing, click the namespace you want to delete to highlight 
the row.  The data in the bottom portion of the window changes to reflect 
information from that namespace.  

3. The Delete option is not available if you selected a subscription namespace.  
Click the enabled Delete button if you selected a local namespace for deletion; a 
confirmation window similar to the following displays. 
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4. Click OK to delete the namespace from the knowledgebase; the namespace is 

deleted from the table on the Namespace Editor window.  All concepts, terms, 
and associations from the namespace are deleted as well.  Click Cancel to ignore 
the deletion. 
 
The DTS Editor will not permit you to delete the current local namespace.  If you 
select the current local namespace for deletion, a window like the following 
displays . 
 

 
 
Before you attempt to delete this namespace again, you must set an alternate local 
namespace.  Refer to the Current Local Namespace discussion for instructions on 
setting the local namespace. 

5. Click Close to close the Namespace Editor window. 

Authority View and Maintenance 
A namespace authority indicates the organization (e.g., U.S. National Library of 
Medicine, U.S. Medical Terms Review) that approved or certified a terminology.  A 
namespace authority must be specified as part of each namespace definition.   

Create an Authority 
Follow this procedure to create an authority that you can assign to a local namespace. 

1. Click the Authority field button on the Namespace Editor floating window.  The 
Authority Editor window displays. 
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2. Click New.  The information for the existing displayed authority is cleared. 
 

 

3. Specify the name of the authority for a local namespace in the Name field. 

4. In the ID field specify the ID number of the authority for a local namespace.  To 
avoid using an ID value already reserved for use by Apelon, enter an authority ID 
number between 1000 and 2000 (inclusive). 

5. Click OK to update the knowledgebase with the new authority, or click Cancel to 
ignore the addition. 

View an Existing Authority for a Local Namespace 
Follow this procedure to view information for an existing, local namespace authority.   

1. For a local namespace, click the Authority field button on the Namespace Editor 
window.  The Authority Editor window displays. 
 

 
 
The information listed is from the first authority in the knowledgebase, listed in 
alphabetical order. 

2. From the Authority field dropdown list, select the authority you want to view (the 
list is alphabetical).  The data in the window changes to reflect information from 
that authority. 

3. The title for this authority displays in the Name field. 

4. The identification number assigned to this authority displays in the ID field.  

5. Click OK when you are through viewing authority information, and to close the 
Authority Editor window. 



 

© 1999-2009 Apelon, Inc.  All Rights Reserved. 

               Page 74 of 147 

Delete an Authority  
Follow this procedure to delete an existing authority.  Note that you can delete the 
authority if it is used by editable local namespaces only; you cannot delete the authority 
if it is used by a subscription namespace, or by a read-only local namespace.  

1. Click the Authority field button on the Namespace Editor window.  The 
Authority Editor window displays. 
 

 
 
The information listed is from the first authority in the knowledgebase, listed in 
alphabetical order. 

2. From the Authority field dropdown list, select the authority you want to delete.  
The data in the window changes to reflect information from that authority. 

3. Click Delete.  A confirmation window similar to the following displays. 
 

 
4. Click OK to delete the authority from the knowledgebase.  Click Cancel to ignore 

the deletion. 
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Association Maintenance 
This section includes basic procedures for creating and maintaining associations between 
concepts or terms.  An association type (e.g., Related To) is assigned to each association 
between concepts or terms to define the nature of the association.  An association may 
also have a qualifier, which provides additional detail regarding the nature of the 
association (e.g., Usually).  Procedures for creating and maintaining association types 
and qualifiers are included as well.   

In a writable namespace you can create associations between concepts and terms that 
reside in one namespace (writable or not) or create associations between concepts and 
terms across namespaces.  Refer to the Create a Concept/Term Association Within a 
Namespace and Map Concepts or Terms Across Namespaces discussions for examples of 
these scenarios. 

Association Types 
Each association you create between two concepts or terms must be assigned a specific 
type to indicate the nature of the link (e.g., one concept is Broader Than the other, or is 
a Parent of the other).  The following procedures pertain to creating and maintaining 
association types. 

Create Association Types 
Follow this procedure to add one or more new association types to an editable 
namespace. 

1. Select Association Types from the Tools menu.  The Association Type Editor 
window displays.   
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Information for each existing association type is listed in a table format.  
Information includes the association type name, the namespace in which the 
association was created, and an indicator that references if the association type is 
for a connection between Two Concepts, between a concept and a synonym 
(Concept With Synonymous Term) or between Two Terms.   
 
To change the sort for the association type list, click the column header for the 
characteristic (Association Type, Namespace, or Connects) on which you want 
to base the sort.  

2. Click New.  The fields in the lower portion of the window are enabled. 

3. In the Name field, enter a name that identifies the type of association you are 
creating. 

4. The association type ID is generated automatically, and displayed in the ID field.  
You cannot modify the generated association type ID.  

5. The association type code is generated automatically, and displayed in the Code 
field.  You cannot modify the generated association type code. 

6. In the Namespace dropdown field, select the local, editable namespace in which 
you are creating this association type.  Only local namespaces are included in the 
list. 

7. The value in the Connects dropdown field indicates if the association type 
represents a connection between Two Concepts, between a concept and a 
synonym (Concept With Synonymous Term) or Two Terms.  Select the kind of 
connection this association type represents.   

8. The value in the Purpose dropdown field indicates how associations assigned this 
type will be used.  Select Mapping when the association is to map concepts or 
terms across namespaces.  Select History when the association is created to 
archive relationships between concepts or terms (for example, if a concept is 
expected to be retired).  Arbitrary (the default) applies for all other associations.  

9. The Inverse Name describes the inverse relationship of this association, and 
displays when you view Inverse Concept Associations (e.g., when you perform a 
search).  For example, "Is Narrower Than" is the inverse of "Is Broader Than." 

10. Click Apply to update the selected local namespace with the new association 
type; the new association type is added to the table on the Association Type Editor 
window.   The Association Type Editor window remains displayed; you can click 
New again and create additional association types in the local namespace. 

11. When you finish creating association types, click Close to close the Association 
Type Editor window. 
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View and Edit an Association Type 
Follow this procedure to view information for an existing association type that exists in 
any namespace, and edit the information if the association type was created in a local, 
writable namespace.      

1. Select Association Types from the Tools menu.  The Association Type Editor 
window displays. 
 

 
 
Information for each existing association type is listed in a table format, in 
columns that you can resize.  Information includes the association type name, the 
namespace in which the association was created, and an indicator that references 
if the association type is for a connection between Two Concepts, between a 
concept and a synonym (Concept With Synonymous Term) or between Two 
Terms.   
 
To change the sort for the association type list, click the column header for the 
characteristic (Association Type, Namespace, or Connects) on which you want 
to base the sort.  

2. In the association type table listing, click the association type you want to view or 
modify to highlight the row.  The lower portion of the window changes to reflect 
information from that association type.  If the association type you selected was 
created in a subscription namespace, none of the fields are editable.  If the 
association type was created in a local, writable namespace, the editable fields are 
enabled. 

3. In the Name field, modify the association type name, as necessary. 
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4. The ID that was generated when the association type was created displays; the ID 
is not editable, for any type of namespace. 

5. The association type Code that was generated when the association type was 
created displays; the code is not editable, for any type of namespace. 

6. The Namespace in which the association type was created is not editable, for any 
type of namespace. 

7. The value in the Connects dropdown field indicates if the association type 
represents a connection between Two Concepts, between a concept and a 
synonym (Concept With Synonymous Term), or Two Terms.  The value in the 
Connects field is editable as long as this is an association type that was created in 
a writable namespace, and no concepts exist that have this association type.  

8. The value in the Purpose dropdown field indicates how associations assigned this 
type will be used.  Select Mapping when the association is to map concepts or 
terms across namespaces.  Select History when the association is created to 
archive relationships between concepts or terms.  Arbitrary (the default) applies 
for all other association types.  

9. The Inverse Name describes the inverse relationship of this association, and  
displays when you view Inverse Concept Associations (e.g., during a search).  
For example, "Is Narrower Than" is the inverse of "Is Broader Than." 

10. Click Apply (which becomes enabled if you make an edit) to update the selected 
local namespace with the association type edits; the Association Type Editor 
window remains displayed for additional edits and/or additions.   
 
To ignore the edits, click on any other association type listed in the table to 
display information specific to that association type.  When the confirmation 
window similar to the following displays, click No to proceed without update of 
the edits.   
 

 
11. Click Close to close the Association Type Editor window. 
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Delete an Association Type  
Follow this procedure to delete an existing association type that was created in a local, 
writable namespace.  If there are associations that exist with this association type, you 
will not be permitted to delete the association type.   

1. Select Association Types from the Tools menu.  The Association Type Editor 
window displays. 
 

 
 
Information for each existing association type is listed in a table format, in 
columns that you can resize.  Information includes the association type name, the 
namespace in which the association was created, and an indicator that references 
if the association type is for a connection between Two Concepts, between a 
concept and a synonym (Concept With Synonymous Term) or between Two 
Terms.   
 
To change the sort for the association type list, click the column header for the 
characteristic (Association Type, Namespace, or Connects) on which you want 
to base the sort.  

2. In the association type table listing, click the association type you want to delete 
to highlight the row.  The lower portion of the window changes to reflect 
information from that association type.   
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3. Click Delete.  A window similar to the following displays if associations with this 
type exist in a local namespace. 
 

 
 
As long as associations of this type exist, you will not be permitted to delete the 
association type.  If no associations with this type exist, a delete confirmation 
window similar to the following displays. 
 

 
 
Click OK to delete the association type from the namespace in which it was 
created; the association type is removed from the table on the Association Type 
Editor window.  Click Cancel to ignore the deletion. 

4. Click Close to close the Association Type Editor window. 

Association Qualifier Types 
For each association you can specify (optionally) an established qualifier type and 
value.  For an association type, a qualifier provides additional detail regarding the nature 
of a concept or term association (for example, the origin of an association, or the degree 
of accuracy of a mapping between concepts, such as Usually).  You can assign a qualifier 
type and value to each association between concepts or terms.  The following procedures 
pertain to creating and maintaining qualifier types. 

Create Association Qualifier Types 
Follow this procedure to add one or more new association qualifier types to a local, 
editable namespace. 

1. Select Qualifier Types from the Tools menu.  The Qualifier Type Editor window 
displays. 
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Information for existing qualifier types (for both associations and properties) is 
listed in a table format in columns you can resize.  Qualifier types from both 
writable and non-writable namespaces are listed.   
 
Table information includes the qualifier type name, the namespace in which the 
qualifier was created, and an indicator that references the kind of association it  
qualifies, either Concept Association or Term Association (the Concept 
Property and Term Property values relate to qualifier types for concept and 
term properties).  To change the sort for the qualifier type list, click the column 
header for the characteristic (Qualifier Type, Namespace, or Qualifies) on 
which you want to base the sort.  

2. Click New.  The fields in the lower portion of the window are enabled. 

3. Specify a name for the new association qualifier type in the Name field. 

4. The qualifier type ID is generated automatically, and displayed in the ID field.  
You cannot modify the generated qualifier type ID.   

5. The qualifier type code is generated automatically, and displayed in the Code 
field.  You cannot modify the generated qualifier type code.   

6. From the Namespace field dropdown list, select the local namespace to which this 
association qualifier type should be written.  Since a qualifier type can be written 
to editable namespaces only, only these namespaces are included in the list. 
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7. The value you select in the Qualifies field dropdown list indicates the kind of 
association this qualifier type will qualify.  Select Concept Association for a 
qualifier of an association between two concepts, or Term Association for a 
qualifier of an association between two terms.  (The Concept Property and 
Term Property options relate to qualifier types for concept and term properties.) 

8. Click Apply to update the selected local namespace with the new association 
qualifier type; the new qualifier type is added to the table on the Qualifier Type 
Editor window.  The Qualifier Type Editor window remains displayed; click New 
again to create additional association qualifier types in the local namespace. 

9. Click Close to close the Qualifier Type Editor window. 

View and Edit an Association Qualifier Type 
Follow this procedure to view information for an existing association qualifier type, and 
to perform any required edits. 

1. Select Qualifier Types from the Tools menu.  The Qualifier Type Editor window 
displays. 
 

 
 
Information for existing qualifier types (for both associations and properties) is 
listed in a table format in columns you can resize.  Qualifier types from both 
writable and non-writable namespaces are listed.   
 
Table information includes the qualifier type name, the namespace in which the 
qualifier was created, and an indicator that references the kind of association it  
qualifies, either Concept Association or Term Association (the Concept 
Property and Term Property options relate to qualifier types for concept and 
term properties).   



 

© 1999-2009 Apelon, Inc.  All Rights Reserved. 

               Page 83 of 147 

To change the sort for the qualifier type list, click the column header for the 
characteristic (Qualifier Type, Namespace, or Qualifies) on which you want to 
base the sort.  

2. In the qualifier type table listing, click the association qualifier type you want to 
view or modify to highlight the row.  The data in the bottom portion of the 
window changes to reflect information for that association qualifier.   
 
If the association qualifier type was created in a local (writable) namespace, you 
can modify the qualifier type Name, as needed.  The Name is not editable if the 
association qualifier type is from a subscription namespace. 

3. The ID generated for the association qualifier type when it was created displays.  
The field is not editable. 

4. The Code generated for the association qualifier type when it was created 
displays.  The field is not editable. 

5. The Namespace in which this association qualifier type was created displays.  The 
field is not editable. 

6. The value in the Qualifies field indicates the kind of association this type qualifies 
(the field is not editable, regardless of the namespace in which the qualifier type 
was created).  Concept Association represents a qualifier of an association 
between two concepts; Term Association represents a qualifier of an association 
between two terms.  (The Concept Property and Term Property options relate 
to qualifier types for concept and term properties; these options are addressed in 
the Properties discussions.). 

7. Click Apply (which becomes enabled if you make an edit) to update the selected 
local namespace with the association qualifier type edits; the Qualifier Type 
Editor window remains displayed if you want to view or edit other qualifier types. 
 
To ignore the edits, click on any other association qualifier type listed in the table 
to display information specific to that association type.  When the confirmation 
window similar to the following displays, click No to proceed without update of 
the edits.   
 

 
8. Click Close to close the Qualifier Type Editor window.  
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Delete an Association Qualifier Type 
Follow this procedure to delete an existing association qualifier type from a local 
namespace.  The association qualifier type must have been created in a local (i.e., 
writable) namespace in order for you to delete it.   

1. Select Qualifier Types from the Tools menu.  The Qualifier Type Editor window 
displays. 
 

 
 
Information for existing qualifier types (for both associations and properties) is 
listed in a table format in columns you can resize.  Qualifier types from both 
writable and non-writable namespaces are listed.   
 
Table information includes the qualifier type name, the namespace in which the 
qualifier was created, and an indicator that references the kind of association it  
qualifies, either Concept Association or Term Association (the Concept 
Property and Term Property options relate to qualifier types for concept and 
term properties).   
 
To change the sort for the qualifier type list, click the column header for the 
characteristic (Qualifier Type, Namespace, or Qualifies) on which you want to 
base the sort.  

2. In the qualifier type table listing, click the association qualifier type you want to 
delete to highlight the row.  The lower portion of the window changes to reflect 
information from that association qualifier type. 

3. Click Delete.  If the association qualifier type you selected for deletion is from a 
non-writable namespace, a message window displays indicating that you cannot 
delete that type.   
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Click OK, then select an association qualifier type from a writable namespace and 
click Delete.   
 
Note: If the qualifier type has been assigned to one or more associations in a local 
namespace, a window displays indicating that you will not be permitted to delete 
this qualifier type.  Click OK to exit the delete process.  If there are no 
associations that have been assigned this qualifier type, a delete confirmation 
window similar to the following displays. 
 

 
4. Click OK to delete the association qualifier type from the namespace; the 

association qualifier type is removed from the table on the Qualifier Type Editor 
window.  Click Cancel to ignore the deletion. 

Create Associations 
Follow this procedure when you want to add one or more new associations between two 
existing concepts or terms in a local namespace.  You also can add an association 
between concepts or terms in a subscription namespace, provided the desired association 
type (and optional qualifier type) was created in the current local namespace. 

1. Select Associations from the Tools menu, or click the Association Editor icon 
on the DTS Editor Main window toolbar.  The Association Editor window 
displays. 
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2. From another displayed panel or window (e.g., Concept Tree panel) drag the 
from concept in the From/To association, then drop it into the From 
Concept/Term field on the Association Editor window.  The name of the 
concept/term displays; the namespace in which it was created displays in brackets.  

3. A new association is written to the local namespace where the association type 
was created.  From the Association Type field dropdown list, select the type of 
association (e.g., Broader Than, Narrower Than) you are creating between the 
concepts or terms.  Only association types from the current local namespace are 
listed, alphabetically.  Refer to the Association Types discussions. 
 
You have the option of filtering the association types that are available from the 
Association Type field dropdown list by creating a pre-defined, filtered list of 
types.  When you attempt to select an association type from the Association Type 
field dropdown list, or select an alternate association type, only the pre-selected 
types display in the list.  Refer to the Filter Association Types discussion.   

4. From another displayed panel or window, drag the target concept/term in the 
association in the To Concept/Term dropdown field.  The name of the to 
concept/term displays; the namespace in which it was created displays in brackets.  
 

 
5. For each association you can add one or more qualifiers, each of which consists of 

an established association qualifier type and value.  Qualifiers provide additional 
detail regarding the nature of a concept or term association (e.g., Usually).   
 
From the Qualifier Type field dropdown list, select a qualifier type to assign to 
this association.  The list reflects association qualifier types that were created in 
the same local namespace where the selected association type was created (refer 
to the Association Qualifier Types discussions). 

6. For the qualifier (type) you selected for this association, specify the association 
qualifier value in the Qualifier Value field.  For each association you can create 
multiple qualifiers of different types, or create occurrences of the same qualifier 
type, each with a separate value.  Click Add after you specify the Qualifier Type 
and Qualifier Value; both are added to the display area in the lower portion of the 
window.  Note the illustration. 
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To remove an individual qualifier type/value combination from the association, 
highlight the appropriate line in the display area and click Remove.  To clear all 
displayed association qualifier type/value combinations, click Clear.   
 
As is the case for association types, you have the option of filtering the 
association qualifier types that are available from the Qualifier Type field 
dropdown list by creating a pre-defined, filtered list of types.  When you attempt 
to select a qualifier type from the Qualifier Type field dropdown list, or select an 
alternate Qualifier type, only the pre-selected types will be included in the list.  
Refer to the Filter Association Qualifier Types discussion later in this section.   

7. Click Apply to add the new association.  If you added this association for a 
concept/term in a subscription namespace, then you later view the concept/term 
(e.g., on the Concept/Term Details panel) the association will display in italics to 
indicate that it was added as local content for the subscription namespace.   
 
The Association Type Editor window remains displayed.  You can click New 
again and create additional associations in the local namespace. 

8. Click Close to close the Association Editor window. 

Filter Association Types  
You can filter the list of association types that are available from the Association Type 
dropdown field.  Using the filtered list may simplify data entry if you are creating many 
associations at one time. 

1. To filter the association type list, click the Association Type field button on the 
Association Editor window.  
 

 
 
The Filter Association Types window displays. 
 

 



 

© 1999-2009 Apelon, Inc.  All Rights Reserved. 

               Page 88 of 147 

In the table in the top portion of the window, association types from all local 
namespaces for which the user has been granted edit permission are listed 
alphabetically for Concept associations (the default) or Term associations (click 
Terms at the top of the window).  Refer to the Create User/Assign Namespace 
Permissions discussion in the DTS Server Operations Guide for procedures on 
assigning namespace edit permissions to a user.    
 
Each association type name is listed, along with the namespace where the type 
was created.  To change the list sort, click the column header for the characteristic 
(Association Type, Namespace) on which you want the sort based.  

2. In the association type table in the upper portion of the window, click one of the 
desired association types to highlight it for selection (you must select each 
association type individually).     

3. Click Add.  The type you selected is added to the Filtered Association Types 
area; the namespace where the association type was created also is listed.   
 

 
4. To remove an individual association type from the filtered list, highlight the 

appropriate line in the Filtered Association Types area and click Remove.  To 
clear all displayed association types from the filtered list, click Clear. 

5. When you are satisfied with your filtered list selections, click OK.  Those filtered  
association types, that also are in the current local namespace, will be the only 
ones listed in the Association Type field dropdown list on the Association Editor 
window.  If the filtered list includes no association types from the current local 
namespace, then no types are listed in the Association Type field dropdown list.  
 
Based on the selections in the previous illustration, the association types Child Of 
and Related To would be listed in the Association Type field dropdown list (the 
filtered association types are in the current local namespace).   
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To select a new set of filtered association types for the list, click the Association 
Type field button again and select from the Filter Association Types window. 

Filter Association Qualifier Types  
You can filter the list of association qualifier types that are available from the Qualifier 
Type dropdown field.  Using the filtered list may simplify data entry if you are entering 
many qualifiers at one time. 

1. To filter the association qualifier type list, click the Qualifier Type field button on 
the Association Editor window.  
 

 
 
The Filter Qualifier Types window displays. 
 

 
 
In the table in the top portion of the window, association qualifier types from all 
local namespaces for which the user has been assigned edit permission are listed 
alphabetically for Concepts (the default) or Terms (click Terms at the top of the 
window).  Refer to the Create User/Assign Namespace Permissions discussion in 
the DTS Server Operations Guide for procedures on assigning namespace edit 
permissions to a user. 
 
Each association qualifier type name is listed, as well as the namespace where the 
type was created.  To change the list sort, click the column header for the 
characteristic (Qualifier Type, Namespace) on which you want the sort based.  
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2. In the qualifier type table in the upper portion of the window, click one of the 
desired association qualifier types to highlight it for selection (you must select 
each type individually).     

3. Click Add.  The association qualifier type you selected is added to the Filtered 
Qualifier Types area in the lower portion of the window; the namespace where 
the qualifier type was created also is listed.   
 

 
4. To remove an individual association qualifier type from the filtered list, highlight 

the appropriate line in the Filtered Qualifier Types area and click Remove.  To 
clear all displayed qualifier types from the filtered list, click Clear. 

5. When you are satisfied with the selections in the filtered list, click OK.   
 
Those filtered association qualifier types that are in the current local namespace, 
and that also match the Association Type local namespace, will be the only ones 
listed in the Qualifier Type field dropdown list on the Association  Editor 
window.  If the filtered list includes no association qualifier types from the current 
local namespace that also match the Association Type local namespace, then no 
types are listed in the Association Type field dropdown list.  
 
Based on the selections in the previous illustration, the types Pending Review 
and Usually would be listed in the Qualifier Type field dropdown list (the 
Association Type and these filtered types are in the current local namespace).   
 

 
 
To select a new set of filtered qualifier types for the list, click the Qualifier Type 
field button again and make your selections on the Filter Qualifier Types window. 
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Synonym Maintenance 
Any concept, in any namespace, can have one or more synonymous terms.  In DTS, a 
term is an occurrence of a character string in a namespace (i.e., terminology).  However, 
an identical string can have different meanings within, or across, namespaces.   

For example, Cold can indicate a temperature reference, and cold can indicate an 
infection.  If you wanted to establish a relationship between the concept Respiratory 
Infection and the term cold (the illness) you could establish cold as a synonym of 
Respiratory Infection. 

This section includes procedures for creating and maintaining associations between 
concepts and synonymous terms.  A synonym always pairs a concept with a synonymous 
term (never a concept with a concept, or a term with a term).   

You must assign an established association type (e.g., Assoc. Concept w/Synon. Term) 
to each synonymous association between concepts and terms.  You can create 
associations between concepts and terms that reside in the same namespace, or across 
namespaces.   

Create Synonyms 
Follow this procedure when you want to create a relationship (i.e., an association) 
between a concept and one or more synonymous terms.  You can create the relationship 
between the concept and the synonymous term if the concept is in a subscription 
namespace, provided the desired association type, and optional qualifier type, were 
created in the current local namespace. 

1. Select Synonyms from the Tools menu.  The Synonym Editor window displays. 
 

   
2. From another displayed panel or window (e.g., Concept Tree panel) drag the 

concept/term for which you are establishing a synonym, then drop it into Concept 
field on the Synonym Editor window.  The name of the concept/term displays; the 
namespace in which it was created displays in brackets. 

3. A new (synonymous) association between the concept and the term you select 
will be written to the local namespace where the association type was created.   
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From the Synonym Type field dropdown list, select the type of association (e.g.,  
Concept to Term Assoc) you are creating between the concept and the term you 
intend to select.   
 
Note that this alphabetized list includes only association types that represent a 
connection between a concept and a synonymous term, created in the current 
local namespace (which displays in brackets).  Refer to the Association Types 
discussions.  
 
You have the option of filtering the association types that are available from the 
Synonym Type field dropdown list by creating a pre-defined, filtered list of types.  
When you attempt to select an association type from the Synonym Type field 
dropdown list, or select an alternate association type, only the pre-selected 
association types will be included in the list.  Refer to the Filter Association Types 
discussion earlier in the guide for instructions on creating a filtered list of 
associations types between concepts and synonymous terms. 

4. From one of the other display windows or panels, drag the term you want to 
establish as a synonym, and drop it into the Term field on the Synonym Editor 
window.  The term displays, with the namespace in which it was created 
displayed in brackets. 
 

 
 
If you would rather create a new term to establish as a synonym, click Create 
New Term.  The Create New Term window displays. 
 

 
 
Specify the Name of the new synonymous term.  From the Namespace field 
dropdown list, select the local, editable namespace in which it will reside (local 
namespaces are listed alphabetically).   
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If the concept for which you are creating a synonymous term is from a 
subscription namespace, you should create the synonymous term in the current 
local namespace.  The synonym you are adding is a New Term (the only option).  
Click OK. 

5. In the event multiple synonyms exist for a specific concept, you can designate that 
one of the synonyms Is Preferred.  Click the Is Preferred field checkbox on the 
Synonym Editor window to designate this synonym as the preferred synonym. 

6. Click Apply to add the synonym to the (editable) namespace.  

7. Click Close to close the Synonym Editor window. 
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Property Maintenance 
A property is a piece of user-defined information that can be linked to a concept or term, 
and can be used for any purpose.  For example, a property can be a textual definition for a 
concept, or can identify the source terminology where a term originated. 

A property type (i.e., definition) is assigned to each property to define the nature of the 
property.  One or more qualifier types and values can be assigned to each property as 
well.  Procedures for creating properties, property types, and property qualifier types are 
included in the following discussions.   

Property Types 

Create Property Types 
Follow this procedure to add a new property type to a local namespace.  You then can 
assign the property type to a concept in any local namespace, or add the property type (as 
local content) for a concept in a subscription namespace. 

1. Select Property Types from the Tools menu.  The Property Type Editor window 
displays.   
 

 
 
Information for each existing property type is listed in a table format, in columns 
you can resize.  Information includes the property type name, the namespace in 
which the property type was created, and an indicator that references if the 
property type is for a property assigned to a Concept or a Term. 
 
To change the sort for the property type list, click the column header for the 
characteristic (Property Type, Namespace, or Attaches To) on which you want 
to base the sort.  
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2. Click New.  The information displayed in the lower portion of the window for the 
existing property type is cleared. 

3. In the Name field, specify the name for the new property type. 

4. The property type ID is generated automatically, and displayed in the ID field.  
You cannot modify the generated property type ID.   

5. The property type code is generated automatically, and displayed in the Code 
field.  You cannot modify the generated property type code.   

6. From the Namespace field dropdown list, select the local namespace in which this 
property type will be created.  The list includes only local, writable namespaces. 

7. From the Attaches To field dropdown list, indicate if the property type is for 
properties that you will assign to a Concept or a Term. 

8. The Value Size refers to the maximum length of a property value that can be 
assigned to this property type.  For a property type that attaches to a concept, 
select (from the field dropdown list) from the options Indexable, Searchable, and 
Big.   
 
Indexable properties are up to 749 characters in length, and provide for the fastest 
access; property types that attach to terms have a value size of Indexable.  
Searchable properties are up to 4000 characters.   
 
A Value Size of Big designates a property type value character string of more than 
4000 characters.  A Big property is not searchable.   

9. For a property type that attaches to a concept, select (from the Word Searchable 
field dropdown list) from the options Word Searchable and Not Word 
Searchable.   
 
Designating a property type as word searchable is the first step in enabling a word 
match search on concept properties of this type.  Property types that attach to 
terms have a value of Not Word Searchable.     
 
After concept properties of this type have been created, the Knowledgebase 
Administrator must run the KB Admin utility.  Refer to the Configure Word 
Match Search discussion in the Knowledgebase Administrators Guide. 

10. Click Apply to update the selected local namespace with the new property type; 
the new property type is added to the table on the Property Type Editor window.  
The Property Type Editor window remains displayed; you can click New again 
and create additional property types in a local namespace. 

11. When you finish creating property types, click Close to close the Property Type 
Editor window. 
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View and Edit a Property Type 
Follow this procedure to view information for an existing property type in any 
namespace, and edit the information if it was created in a local, writable namespace.      

1. Click Property Types on the DTS Editor Main window’s Tools menu.  The 
Property Type Editor window displays. 
 

 
 
Information for each existing property type is listed in a table format, in columns 
you can resize.  Information includes the property type name, the namespace in 
which the property type was created, and an indicator that references if the 
property type is for a property assigned to a Concept or a Term. 
 
To change the sort for the property type list, click the column header for the 
characteristic (Property Type, Namespace, or Attaches To) on which you want 
to base the sort. 

2. Click the property type you want to view or modify to highlight the row.  The 
lower portion of the window changes to reflect information from that type.   
If the property type you selected was created in a subscription namespace, none of 
the fields are editable.  If the property type was created in a local, writable 
namespace, the editable fields are enabled.   

3. In the Name field, modify the property type name, as necessary. 
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4. The ID code generated for the property type when it was created displays.  The ID 
is not editable, regardless of the namespace in which the property type was 
created. 

5. The Code generated for the property type when it was created displays; the code 
is not editable, regardless of the namespace in which the type was created. 

6. The Namespace in which the property type was created is not editable, for any 
type of namespace. 

7. The Attaches To value indicates if the property type is for properties that you will 
assign to a Concept, or a Term.  The field is not editable if the property type is in 
use currently for a concept or a term. 

8. The Value Size refers to the maximum length of a property value that can be 
assigned to this property type (Indexable, Searchable, and Big).  The field is not 
editable if the property type is in use currently for a concept or a term. 

9. In the Word Searchable field dropdown list, the options are Word Searchable 
and Not Word Searchable.  The field is not editable, regardless of the namespace 
in which the property type was created. 

10. Click Apply (which becomes enabled if you make an edit) to update the 
namespace with the edits.  The Property Type Editor window remains displayed 
for additional edits and/or additions.   
 
To ignore the edits, click on any other property type listed in the table to display 
information specific to that property type.  When the confirmation window similar 
to the following displays, click No to proceed without update of the edits.   
 

 
11. Click Close to close the Property Type Editor window. 
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Delete a Property Type 
Follow this procedure to delete an existing property type from a local namespace.     

1. Click Property Types on the DTS Editor Main window’s Tools menu.  The 
Property Type Editor window displays. 
 

 
 
Information for each existing property type is listed in a table format, in columns 
you can resize.  Information includes the property type name, the namespace in 
which the property type was created, and an indicator that references if the 
property type is for a property assigned to a Concept or a Term. 
 
To change the sort for the property type list, click the column header for the 
characteristic (Property Type, Namespace, or Attaches To) on which you want 
to base the sort. 

2. Click the property type you want to delete to highlight the row.  The lower portion 
of the window changes to reflect information from that property type.   

3. Click Delete.  A window similar to the following displays if properties with this 
type are in use for concepts in a local namespace. 
 

 
 
As long as concepts with this property type exist, you will not be permitted to 
delete the property type.  If no concepts have properties with this type, a delete 
confirmation window similar to the following displays. 
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4. Click OK to delete the property type from the namespace; the property type is 

removed from the table on the Property Type Editor window.  Click Cancel to 
ignore the deletion. 

Property Qualifier Types 
For each property you can specify an established qualifier type and value.  These 
provide additional detail regarding the nature of a concept or term property (e.g., a 
property effective date, or an indicator reflecting that the property is Current).   

You can assign a type and value to each concept or term property qualifier.  The 
following procedures pertain to creating and maintaining property qualifier types. 

Create Property Qualifier Types 
Follow this procedure to add new property qualifier types to a local namespace. 

1. Select Qualifier Types from the Tools menu.  The Qualifier Type Editor window 
displays. 
 

 
 
Information for existing qualifier types (for both associations and properties) is 
listed in a table format in columns you can resize.  Qualifier types from both 
writable and non-writable namespaces are listed.   
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Table information includes the qualifier type name, the namespace in which the 
qualifier was created, and an indicator that references if the type qualifies 
properties for concepts or terms (Concept Property, Term Property).  The 
Concept Association and Term Association values refer to qualifiers you 
establish for associations within, or across, namespaces.   
 
To change the sort for the qualifier type list, click the column header for the 
characteristic (Qualifier Type, Namespace, or Qualifies) on which you want to 
base the sort.  

2. Click New.  The information displayed in the lower portion of the window for the 
existing qualifier type is cleared. 

3. Specify a name for the new property qualifier type in the Name field. 

4. The qualifier type ID is generated automatically, and displayed in the ID field.  
You cannot modify the generated qualifier type ID.   

5. The qualifier type code is generated automatically, and displayed in the Code 
field.  You cannot modify the generated qualifier type code.   

6. From the Namespace field dropdown list, select the local namespace to which this 
property qualifier type should be written.  Since a qualifier type can be written to 
local, editable namespaces only, only these namespaces are included in the list. 

7. The value you select in the Qualifies field dropdown list indicates if this qualifier 
type will qualify properties for concepts or terms.  Select Concept Property or 
Term Property, as appropriate (Concept Association and Term Association 
refer to qualifiers you establish for associations within, or across, namespaces). 

8. Click Apply to update the selected local namespace with the new property 
qualifier type; the new qualifier type is added to the table on the Qualifier Type 
Editor window.  The Qualifier Type Editor window remains displayed; you can 
click New again and create additional property qualifier types in the local 
namespace. 

9. Click Close to close the Qualifier Type Editor window. 
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View and Edit a Property Qualifier Type 
Follow this procedure to view information for an existing property qualifier type, and to 
perform any required edits. 

1. Select Qualifier Types from the Tools menu.  The Qualifier Type Editor window 
displays. 
 

 
 
Information for existing qualifier types (for both associations and properties) is 
listed in a table format in columns you can resize.  Qualifier types from both 
writable and non-writable namespaces are listed.   
 
Table information includes the qualifier type name, the namespace in which the 
qualifier was created, and an indicator that references if the type qualifies 
properties for concepts or terms (Concept Property, Term Property); the 
Concept Association and Term Association values refer to qualifiers you 
establish for associations within, or across, namespaces.   
 
To change the sort for the qualifier type list, click the column header for the 
characteristic (Qualifier Type, Namespace, or Qualifies) on which you want to 
base the sort.   

2. In the qualifier type table listing, click the property qualifier type you want to 
view or modify to highlight the row.  The data in the bottom portion of the 
window changes to reflect information for that property qualifier.   
 
If the property qualifier type was created in a local (writable) namespace, you can 
modify the qualifier type Name, as needed.  The Name is not editable if the 
property qualifier type is from a subscription namespace. 
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3. The ID generated for the property qualifier type when it was created displays.  
The field is not editable, regardless of the namespace in which the qualifier type 
was created. 

4. The Code generated for the property qualifier type when it was created displays.  
The field is not editable, regardless of the namespace in which the qualifier type 
was created. 

5. The Namespace in which this property qualifier type was created displays.  The 
field is not editable. 

6. The value in the Qualifies field dropdown list indicates if this qualifier type 
qualifies properties for concepts or terms (Concept Property or Term 
Property).  The field is not editable, regardless of the namespace in which the 
qualifier type was created. 

7. Click Apply (which becomes enabled if you make an edit) to update the selected 
local namespace with the property qualifier type edits.  The Qualifier Type Editor 
window remains displayed if you want to view or edit other qualifier types. 
 
To ignore the edits, click on any other property qualifier type listed in the table to 
display information specific to that property qualifier type.  When the 
confirmation window similar to the following displays, click No to proceed 
without update of the edits.   
 

 
8. Click Close to close the Property Type Editor window. 
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Delete a Property Qualifier Type 
Follow this procedure to delete an existing qualifier type from a local namespace.  The 
qualifier type must have been created in a local, writable namespace in order for you to 
delete it.        

1. Select Qualifier Types from the Tools menu.  The Qualifier Type Editor window 
displays. 
 

 
 
Information for existing qualifier types (for both associations and properties) is 
listed in a table format in columns you can resize.  Qualifier types from both 
writable and non-writable namespaces are listed.   
 
Table information includes the qualifier type name, the namespace in which the 
qualifier was created, and an indicator that references if the type qualifies 
properties for concepts or terms (Concept Property, Term Property); the 
Concept Association and Term Association values refer to qualifiers you 
establish for associations within, or across, namespaces.  To change the sort for 
the qualifier type list, click the column header for the characteristic (Qualifier 
Type, Namespace, or Qualifies) on which you want to base the sort. 

2. In the qualifier type table listing, click the property qualifier type you want to 
delete to highlight the row.  The lower portion of the window changes to reflect 
information from that property qualifier type. 

3. Click Delete.  If the property qualifier type you selected for deletion is from a 
non-writable namespace, a message window displays indicating that you cannot 
delete that type.   
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Click OK, then select a property qualifier type from a writable namespace and 
click Delete.  Note: If the qualifier type has been assigned to one or more 
properties in a local namespace, a window displays indicating that you will not be 
permitted to delete this qualifier type.  Click OK to exit the delete process.   
 
If there are no properties that have been assigned this qualifier type, a delete 
confirmation window similar to the following displays. 
 

 
4. Click OK to delete the property qualifier type from the namespace; the property 

qualifier type is removed from the table on the Qualifier Type Editor window.  
Click Cancel to ignore the deletion. 

Assign Properties to a Concept 
Follow this procedure when you want to add one or more established properties to an 
existing concept or term in a local namespace.  You also can add a property to a 
concept/term in a subscription namespace, provided the desired property type (and 
optional qualifier type) exists in the current local namespace. 

1. Select Properties from the Tools menu, or click the Property Editor icon on the 
DTS Editor Main window toolbar.  The Property Editor window displays.   
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2. From another displayed panel or window (e.g., Concept Tree panel) drag the 
concept/term for which you want to create a property and drop it into the 
Concept/Term field.  The name of the concept/term displays, and the namespace 
in which it exists displays in brackets.   

3. A property type is the pre-established identifier that defines the property.  From 
the Property Type field dropdown list, select a property definition to be assigned 
to the concept or term.  If the concept/term in the Concept/Term field is from a 
subscription namespace, the Property Type dropdown list includes only property 
types created in the current local namespace, listed alphabetically.   
 
If the Concept/Term was created in a local namespace, the Property Type list 
includes property types created in the current local namespace, but only if the 
Concept/Term also was created in the current local namespace.  If the 
concept/term was not created in the current local namespace, the Property Type 
field dropdown list will be empty.  Refer to the Property Types discussions. 
 
You have the option of filtering the property types that are available from the 
Property Type field dropdown list by creating a pre-defined, filtered list of types.  
When you attempt to select a property type from the Property Type field 
dropdown list, or select an alternate property type, only the pre-selected types will 
be included in the list.  Refer to the Filter Property Types discussion.   

4. For the property definition (type) assigned to this concept/term, enter the property 
value in the Property Value text area.  This area accommodates the entry of large 
amounts of text, as well as formatted text (e.g., paragraphs, bulleted items, etc.).  
A single concept/term can have multiple occurrences of the same property type, 
each with a separate, unique value. 
 

 
5. For each property you may specify an established property qualifier type and 

value to  provide details regarding the nature of a concept or term property (e.g., 
Current).  From the Qualifier Type field dropdown list, select the qualifier to 
assign to this property.   
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The list includes only those property qualifier types that were created in the same 
local namespace where the selected Property Type was created (refer to the 
Property Qualifier Types discussion earlier in the guide).  For the property 
qualifier (type) you selected for this concept or term, specify the qualifier value in 
the Qualifier Value field.  For each property you can create multiple occurrences 
of the same qualifier type, each with a separate, unique value.   
 
Click Add after you specify the property Qualifier Type and Qualifier Value; both 
are added to the display area in the lower portion of the window.  Note the 
illustration. 
 

  
 
To remove an individual qualifier type/value combination from the property, 
highlight the appropriate line in the display area and click Remove.  To clear all 
displayed qualifier type/value combinations, click Clear.   
 
You have the option of filtering the property qualifier types that are available 
from the Qualifier Type field dropdown list by creating a pre-defined, filtered list 
of types.  When you attempt to select a property qualifier type from the Qualifier 
Type field dropdown list, or select an alternate Qualifier type, only the pre-
selected types will be included in the list.  Refer to the Filter Property Qualifier 
Types discussion later in this section.   

6. Click Apply to add the new property to the current local namespace.  If you added 
this property to a concept in a subscription namespace, then you later view the 
concept/term (e.g., on the Concept/Term Details panel) the property will display 
in italics to indicate it was added as local content for the subscription namespace.   

Filter Property Types  
You can filter the list of property types that are available from the Property Type 
dropdown field.  Using the filtered list may simplify data entry if you are assigning many 
properties to concepts at one time. 

1. To filter the property type list, click the Property Type field button on the 
Property Editor window.  
 

 
 
The Filter Property Types window displays. 
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In the table in the top portion of the window, property types from all local 
namespaces for which the user has been granted edit permission are listed 
alphabetically.  Refer to the Create User/Assign Namespace Permissions 
discussion in the DTS Server Operations Guide for procedures on assigning 
namespace edit permissions to a user. 
 
Each property type name is listed, as well as the namespace where the property 
type was created.  To change the list sort, click the column header for the 
characteristic (Property Type, Namespace) on which you want the sort based.  

2. In the property type table in the upper portion of the window, click one of the 
desired property types to highlight it for selection (you must select each property 
type individually).     

3. Click Add.  The property type you selected is added to the Filtered Property 
Types area in the lower portion of the window.  The namespace in which each 
selected property type was created is listed as well.   
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4. To remove a type from the filtered list, highlight the appropriate line in the 
Filtered Property Types area and click Remove.  To clear all types, click Clear. 
The filtered list may include property types from more than one local namespace.   

5. When you are satisfied with your filtered list selections, click OK.   

6. If the Concept/Term on the Property Editor window was created in a subscription 
namespace, those filtered property types that also are in the current local 
namespace will be the only ones listed in the Property Type field dropdown list.   
 
If the Concept/Term on the Property Editor window was created in a local 
namespace, the property type list includes property types created in the current 
local namespace, but only if the Concept/Term on the Property Editor window 
also was created in the current local namespace.  If the concept/term was not 
created in the current local namespace, the Property Type field dropdown list will 
be empty.  Refer to the Property Types discussions. 
 
Based on the selections in the previous illustration, the property types Approval 
Status and Current Status would be listed in the Property Type field dropdown 
list on the Property Editor window (the filtered property types are in the current 
local namespace, which matches the local namespace where the Concept/Term 
was created). 
 

 
 
To select a new set of filtered property types for the list, click the Property Types 
field button again and make your selections on the Filter Property Types window. 

Filter Property Qualifier Types  
You can filter the list of property qualifier types that are available from the Qualifier 
Type dropdown field.  Using the filtered list may simplify data entry if you are entering 
many property qualifiers at one time. 

1. To filter the property qualifier type list, click the Qualifier Type field button on 
the Property Editor window.  
 

 
 
The Filter Qualifier Types window displays. 
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In the table in the top portion of the window, property qualifier types from all 
local namespaces for which the user has been granted edit permission are listed 
alphabetically.  Refer to the Create User/Assign Namespace Permissions 
discussion in the DTS Server Operations Guide for procedures on assigning 
namespace edit permissions to a user. 
 
Each qualifier type name is listed, as well as the namespace where the qualifier  
type was created.  To change the list sort, click the column header for the 
characteristic (Qualifier Type, Namespace) on which you want the sort based.  

2. In the qualifier type table in the upper portion of the window, click one of the 
desired property qualifier types to highlight it for selection (you must select each 
type individually).     

3. Click Add.  The property qualifier type you selected is added to the Filtered 
Qualifier Types area in the lower portion of the window; the namespace for each 
selected qualifier is listed as well.   
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4. To remove an individual property qualifier type from the filtered list, highlight the 
appropriate line in the display area and click Remove.  To clear all displayed 
qualifier types from the filtered list, click Clear. 

5. When you are satisfied with the selections in the filtered list, click OK.   
 
Those filtered  property qualifier types that also are in the current local 
namespace, and that also match the Property Type local namespace, will be the 
only ones listed in the Qualifier Type field dropdown list on the Property Editor 
window.  If the filtered list includes no property qualifier types from the current 
local namespace that also match the Property Type local namespace, then no 
types are listed in the Property Type field dropdown list.  
 
Based on the selections in the previous illustration, the qualifier types Concept 
Review Needed, Concept Review Pending, and Concept Review Performed 
would be listed in the Qualifier Type field list on the Property Editor window (the 
filtered qualifier types are in the current local namespace, which matches the local 
namespace of the Property Type). 
 

 
 
To select a new set of filtered property qualifier types, click the Qualifier Type 
field button again and make your selections on the Filter Qualifier Types window. 
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Concept Maintenance 
The discussions in this section relate to viewing details of existing concepts or terms, and 
the creation of a new concept or term in a local namespace.  

View Concept/Term Details  
The Concept/Term Details panel displays as the default in the right pane of the DTS 
Editor Main window when it first opens.  For an Ontylog namespace you want to view, 
you can display detailed attribute information for each concept or term that you drag from 
any other display window or panel on the Main window.  For a Thesaurus namespace, 
you can view details for any association that you drag from another window or panel on 
the main window.   

In the following illustration, the concept ALBUMIN PREPARATION, from an Ontylog 
namespace, was dragged from the Concept Tree tab into the Concept/Term Details panel.  
The attributes (i.e., attribute folders) are expanded for view. 
 

 
 
When you expand all, or selected attributes for view, the Concept/Term Details panel 
retains those tree settings for the next concept displayed in the view.  Only those 
attributes that were expanded for the previous concept are “auto-expanded” for the new 
concept in the view.  
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In the next illustration, a focus concept from a Thesaurus namespace was dragged from 
the Concept Tree tab into the Concept/Term Details panel.  The attributes are expanded 
for view. 

 

Configure Concept/Terms Details Panel View 
To select which attributes will display if there is a concept in the Concept/Term Details 
panel, right click the name of the concept you dragged into the panel, then click 
Configure View.  The Configure Concept/Term Details View window displays, listing 
the attribute view options available when a concept is displayed in the panel. 
 

 
As the default, all concept attributes are selected for display with the exception of 
Superconcepts, Subconcepts, and Subsets.  To remove an attribute from the detail 
display, click the checkbox adjacent to that attribute to remove the check mark.  To add 
an attribute, click the checkbox to insert a check mark.   

Click OK when finished.  Your display configuration is retained for later DTS sessions.  
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To select which attributes will display if there is a term displayed in the Concept/Term 
Details panel, right click the name of the term you dragged into the panel, then click 
Configure View.  The Configure Concept/Term Details View window displays, listing 
the attribute view options available when a term is displayed in the panel. 
 

 
As the default, all term attributes are selected for display with the exception of  Subsets.  
To remove an attribute from the detail display, click the checkbox adjacent to that 
attribute to remove the check mark.  To add an attribute, click the checkbox to insert a 
check mark.  Click OK to save your display configuration. 

Depending on your selected configuration, the following concept/term detail attributes 
will display.  The icon that identifies each attribute is indicated.   

Note that only the attributes present for a specific concept or term display on the 
Concept/Term Details panel, regardless of the configuration.  For example, if a concept 
has no associations connected with it, the Associations folder does not display.  

                        Concept (indicates displayed detail is for a concept)   
                        Term (indicates displayed detail is for a term)   

Concept Code   
Concept ID   
Concept Namespace   
Concept Synonyms   
         o Preferred Term 
Concept Properties   
         o Concept Property Qualifiers    
Superconcepts   
Subconcepts   
Concept Roles   
Concept Inverse Roles   
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Associations   
         o Associated Concepts ("To" Concepts)   
         o Association Qualifiers   
Inverse Associations   
         o Inversely Associated Concepts ("From" Concepts)   
         o Association Qualifiers   
Namespace Subsets   

For local, writable namespaces, after you view concept details, you may select one of the 
available editor functions and make modifications to that specific concept’s displayed 
attributes.  Procedures for creating a new concept in a local namespace, and for viewing 
and editing existing concept attributes, are provided later in this section. 

Attribute List Control 

You can set the maximum number of attributes to be listed when you expand each 
attribute folder for a concept (i.e., Associations, Properties, etc.) on the Concept/Term 
Details panel.  In the Attribute Limit field, specify the maximum number of attributes to 
list for each detail component; 100 is the default (specify 0 to list no concept attributes).   

For example, enter 10 in the Attribute Limit field to limit the number of listed 
associations, properties, roles, etc., for each concept to 10.  Note: All superconcepts and 
subconcepts display for each concept when you expand the respective folder, regardless 
of the threshold you specify in the Attribute Limit field.     

Navigate to Other Concepts or Terms From Displayed Detail  
On the Concept/Term Details panel you can navigate to (and display attribute details for) 
another concept or term from the current attribute detail view.  In the following 
Concept/Term Details panel illustration, the highlighted concept Biologic Structures of 
Recipient is a superconcept of the displayed concept DRAFT Gene Product. 

 
To display detail attributes for Biologic Structures of Recipient, drag that concept and 
drop it into any empty area on the Concept/Term Details panel.  The Concept/Term 
Details panel display refreshes, referencing attributes for Biologic Structures of 
Recipient. 
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The previous illustrations reflect navigation to another concept within the same 
namespace.  You also can navigate to, and display details for, a concept or term within 
another namespace.  Note the inverse association highlighted in the next illustration.    

 
Drag the selected inverse association and drop it into an empty area on the Concept/Term 
Details panel.  The panel display refreshes, referencing the concept or term included in 
the inverse association you selected.   

Note that new concept displayed in this illustration is from a different namespace. 

 

Different Namespace  
Referenced 
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For any displayed concept or term, you can navigate to those concepts or terms 
referenced in the displayed details (associations, inverse associations, roles, inverse roles, 
concepts or terms referenced as superconcepts, subconcepts, synonyms).    

View Subsets in Which a Concept Resides 
In addition to listing a concept’s attributes in the Concept/Term Details panel, you have 
the option to list all subsets in which the concept in the view is included.  Confirm that 
the Subsets option is checked in the Configure Concept/Term Details View window. 

 
If the concept is included in one or more subsets, a Subsets folder is added to the 
Configure Concept/Term Details View panel view.  Each subset in which the concept is 
included is listed in the folder, adjacent to the  icon. 

 
If a subset is modified so that the concept in the view no longer is included in the subset, 
that subset is removed from the listing. 

You can drag a subset listed on the Concept/Term Details panel, then drop it onto the 
Subset Expression Editor window to view and/or modify concept selection parameters for 
the subset.  Refer to the DTS Subset Editor Users Guide for procedures on creating and 
maintaining subsets. 

Subsets View Option 

Subsets Folder
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Concept Name and Attribute Text Wrapping 
If lengthy concept names and/or attribute text extend beyond the border of the Concept/ 
Term Details panel, the text will wrap around to a new line.  The concept name or 
attribute text also will be enclosed in brackets. 

 
If you enlarge the Concept/Term Details panel, then drag a different concept into the 
panel, the enlarged panel size setting is retained.  The text wrapping and brackets will be 
removed if they are not required in the larger panel. 

 
 

     Wrapped   
     Concept  
     Attributes  
     in Brackets 

Text Wrap and 
Brackets are 
Retained Only  
if Required 

Wrapped 
Concept Name  
in Brackets 
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View Concept/Term Details Panel History Using Forward and Back Buttons  
For your reference, a history is provided of the concepts and/or terms that were displayed 
previously in the same instance of the Concept/Term Details panel.  Use the Forward 
and Back buttons to navigate through concepts and terms that you viewed or edited 
earlier.   

For example, if you are viewing a concept or term in the Concept/Term Details panel, 
then subsequently drag a different concept or term into the panel for view or edit, the 
Back button becomes enabled.  Note the illustration. 

 

 
Click the Back button to review the concept that displayed in the panel previously (i.e., 
the concept in the Concept/Term Details panel’s history).  The view always reflects the 
current Configure View setting for the Concept/Term Details panel.  

 As soon as you click the Back button, the Forward button becomes enabled.   

 

 
Click the Forward button repeatedly to redisplay the concept you dragged into the 
Concept/Term Details panel most recently.  The button becomes disabled (grayed out) 
when the most recent concept is displayed.   

The displayed history reflects the latest version of a concept or term.  If a concept or term 
is updated after it was put in the history, the latest version of the concept or term is 
displayed when you click the Forward and Back buttons. 

The Concept/Term Details panel history is available only for the current connection 
instance.  The Concept/Term Details panel history will be reset when you disconnect 
from the DTS Editor. 

  

Back Button Enabled 

Forward Button Enabled 
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Add a New Concept/Term to a Local Namespace 

Create the New Concept 
Follow this procedure to add a new concept or term to an established local namespace.   

1. To create a new concept in a namespace, click New in the Concept/Term Details 
tab in the right panel of the DTS Main window.  The Create New Concept/Term 
window displays.  
 

 
2. Enter the name of the new concept in the Name field. 

3. From the Namespace field dropdown list, select the local namespace to which the 
new concept will be added (only local, writable namespaces are listed).  

4. The default, New Concept, applies if you are adding a new concept to the local 
namespace.  Click New Term to add a new term to the local namespace. 

5. To cancel the addition of the concept or term to the namespace, click Cancel.  
The Create New Concept/Term window closes. 
 
Click OK to add the concept or term to the selected namespace.  The new concept 
name displays in the Concept/Term Details panel, and references the namespace 
in which you created it.   
 
The Concept Code and ID (which are assigned to the new concept automatically) 
display as well.  Note that each concept ID is tracked so that if the concept is 
deleted at a later time, that concept ID is prevented from being reassigned to 
another new concept.   
 
To change the format of the assigned concept code and/or ID, follow the 
procedures outlined in the Code and ID Generator discussion later in the guide.    
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Change the Name of a Concept 
You can change the name of an existing concept only if the namespace is writable. 

1. Make sure the concept you want to modify displays on the Concept/Term Details 
panel.  Right-click on the concept name. 

2. On the displayed option list, click Rename.  The Rename Concept/Term window 
displays, referencing the existing concept name.   
 

 
3. Enter a New Name for the concept, and click OK.  If the concept is in a 

namespace that is not writable, the following window displays.   
 

 
 
Click OK to bypass the renaming of the concept. 
 
If the concept you want to rename is in a writable namespace, the new name 
displays immediately in the Concept/Term Details panel.  The namespace is 
updated with the new concept name.   

Add a Synonym to a Concept 
Use one of the following methods to add a synonym (with an association type established 
as local content in a local namespace) between concepts or terms in a subscription 
namespace.  The synonymous term can exist in the same namespace as the concept, or in 
a different namespace.  A synonym always pairs a concept with a synonymous term 
(never a concept with a concept, or a term with a term).   

If you are creating a synonymous term as local content for a concept in a subscription 
namespace, the association type you select must be created already in the current local 
namespace; the resulting new synonym will be written to the current local namespace as 
well.  You have the option of defining a new character string as the synonymous term, 
and linking that term to a concept.  
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Create a Synonym – Click on Concept Name in Concept/Term Details Panel 

Follow this procedure to link a synonymous term to a concept by right clicking on the 
new concept name in the Concept/Term Details panel. 

1. If the new concept is displayed in the Concept/Term Details panel, right-click on 
the concept name.  Select Add Synonym from the displayed options.   
 
To add a synonym to an existing concept, drag the concept from another 
displayed window or panel and drop it on the Concept/Term Details panel.  Right-
click on the concept name, then select Add Synonym from the displayed options.    
 
The New Synonym window displays. 
 

 
 
The concept from the Concept/Term Details panel displays automatically in the 
Concept field. 

2. If you are creating a synonymous term for a concept in a subscription or local 
namespace, only association types from the current local namespace are listed 
(alphabetically) in the Synonym Type dropdown field, and only those association 
types that represent connections between concepts and synonymous terms 
(Concept to Term Assoc); select the appropriate association type.  A new 
(synonymous) association between the concept and the term you select will be 
written to the local namespace where the association type was created.  Refer to 
the Association Types discussions.  
 
You have the option of filtering the association types that are available from the 
Synonym Type field dropdown list by creating a pre-defined, filtered list of types.  
When you attempt to select an association type from the Synonym Type field 
dropdown list, or select an alternate association type, only the pre-selected 
association types will be included in the list.  Refer to the Filter Association Types 
discussion.   
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3. From one of the other display windows or panels, drag the concept/term you want 
to establish as a synonym, and drop it into the Term field on the New Synonyms 
window.  The term can be from the same namespace as the concept, or from a 
different namespace. 

4. If you would rather create a new term (i.e., one not already existing in a 
namespace) to establish as a synonym, click Create New Term.  The Create New 
Term window displays. 
 

 
 
Specify the Name of the new synonymous term.  From the Namespace field 
dropdown list, select the local, editable namespace in which it will reside (local 
namespaces are listed alphabetically).  The synonym you are adding is a New 
Term (the only option).   

5. Click OK.  The Create New Term window closes. 

6. In the event multiple synonyms exist for a specific concept, you can designate that 
one of the synonyms Is Preferred.  On the New Synonym window, click the Is 
Preferred field checkbox to designate this synonym as the preferred synonym.  
This synonym will be referenced as Preferred when you expand the Synonyms 
folder on the Concept/Term Details panel. 
 

 
7. Click OK on the New Synonym window to add the synonym to the current local 

namespace.  In the Synonyms folder for the concept on the Concept/Term Details 
panel, the synonym displays in italics (to indicate that it is subscription content 
that was written to a local namespace).  
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Create a Synonym – Control/Drag Concept into Concept/Term Details Panel 

Follow this procedure to link a synonymous term to a concept displayed in the 
Concept/Term Details panel using the concept Control/Drag option.   

1. Make sure the concept for which you want to add a synonymous term displays in 
the Concept/Term Details panel.   

2. From another displayed panel or window (or another instance of the Concept/ 
Term Details panel) select the term you want to add as a synonymous term, then 
drag it to the Concept/Term Details panel.   
 
The term can be from the same namespace as the concept, or from a different 
namespace, but the association type for it must reside in a local namespace (i.e., 
the association type must be created in a local namespace).   

3. Hold the Control key down before you drop this concept into the Concept/Term 
Details panel.   
 
The New Synonym window displays.  The concept from the Concept/Term Details 
panel displays in the Concept field, and the dragged concept populates the Term 
field (the namespace in which the concept resides is included in brackets). 
 

     
4. Click OK on the New Synonym window to add the synonym to the current local 

namespace.  When you expand the Synonyms folder for the concept on the 
Concept/Term Details panel, the synonym displays in italics (to indicate that it is 
subscription content that was written to a local namespace).  

Create a Synonym – Control/Drag Local Synonym into Concept/Term Details Panel 

Follow this procedure to select an existing synonym (in a local namespace) displayed in 
another panel, then add the synonym itself to a concept displayed in the Concept/Term 
Details panel using the concept Control/Drag option.   

1. Make sure the concept for which you want to add a synonymous term displays in 
the Concept/Term Details panel.   
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2. From a concept displayed in another panel or window (or in another instance of 
the Concept/Term Details panel) select the local synonym you want to add; select 
the local synonym itself (not the entire concept); local synonyms display in 
italics.  

3. Drag the selected synonym to the Concept/Term Details panel.  Hold the Control 
key down before you drop the synonym into the Concept/Term Details panel; the 
dragged synonym displays in italics.    

Edit a Synonym 
Follow this procedure to modify an existing synonym for a concept.  You can modify an 
existing synonym for a concept in a subscription namespace, but only if the association 
type exists in a local namespace (i.e., the synonym is content in a local namespace, and is 
listed in italics).  

1. To edit a synonym for an existing concept, drag the concept from another 
displayed window or panel and drop it on the Concept/Term Details panel.   

2. For the displayed concept, click on the Synonyms folder to expand it.  The 
existing synonyms for the concept display.  Right-click on the synonym you want 
to edit, then select Modify Synonym from the displayed options.   
 

 
 
The Modify Synonym floating window displays, referencing the concept and the 
synonymous term, as well as the namespace in which each resides. 
 

 
3. Make the desired edits, then click OK to update the appropriate namespace(s). 
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Delete a Synonym 
Follow this procedure to delete an existing synonym for a concept that was created as  
content in a local namespace. 

1. To delete a synonym for an existing concept in a local namespace, drag the 
concept from another displayed window or panel and drop it on the Concept/Term 
Details panel.   

2. For the displayed concept, click on the Synonyms folder to expand it.  The 
existing synonyms for the concept/term display.  Each synonym that is content in 
a local namespace displays in italics. 
 

 
3. Right-click on the synonym you want to delete, then select Delete Synonym from 

the displayed options.  Note that if the synonym is in a namespace that is not 
editable, the Delete Synonym option is not available.   
 
The following confirmation window displays. 
 

 
4. Click OK to delete the synonym from the local namespace where it resides.  Click 

Cancel to ignore the deletion and close the window. 

Add a Property to a Concept or Term 
Follow this procedure to create a new property (as local content in the current local 
namespace) for a concept or term that resides in a subscription namespace. 

1. Drag the concept/term for which you want to add a property into the 
Concept/Term Details panel. 

2. Right-click on the concept/term name on the Concept/Term Details panel, then 
select Add Property from the displayed options.  The Add Property window 
displays. 
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The concept/term from the Concept/Term Details panel displays automatically in 
the Concept/Term field, and the namespace in which it exists displays in brackets.     

3. A property type is a pre-established identifier that defines the property.  From the 
Property Type field dropdown list, select a property definition to be assigned to 
the concept or term.  If the Concept/Term is from a subscription namespace, the 
Property Type dropdown list includes only property types created in the current 
local namespace, listed alphabetically.   
 
If the Concept/Term was created in a local namespace, the Property Type list 
includes property types created in the current local namespace, but only if the 
Concept/Term also was created in the current local namespace.  If the 
concept/term was not created in the current local namespace, the Property Type 
field dropdown list will be empty.  Refer to the Property Types discussions. 
 
You have the option of filtering the property types that are available from the 
Property Type field dropdown list by creating a pre-defined, filtered list of 
property types.  When you attempt to select a property type from the Property 
Type field dropdown list, or select an alternate property type, only the pre-selected 
types will be included in the list.  Refer to the Filter Property Types discussion 
earlier in the guide.   

4. For the property definition (type) assigned to this concept or term, specify the 
property value in the Property Value text area.  This area accommodates the entry 
of large amounts of text, as well as formatted text (e.g., paragraphs, bulleted 
items, etc.).  A single concept or term can have multiple occurrences of the same 
property type, each with a separate, unique value. 
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5. For each property you may specify an established qualifier type and value; these 

provide additional detail regarding the nature of a concept or term property (e.g., 
Current).  From the Qualifier Type field dropdown list, select the qualifier to 
assign to this property.  The list includes only those property qualifier types that 
were created in the same local namespace where the selected property type was 
created (refer to the Property Qualifier Types discussions). 

6. For the property qualifier (type) you selected for this concept or term, specify the 
qualifier value in the Qualifier Value field.  For each property you can create 
multiple occurrences of the same qualifier type, each with a separate, unique 
value.   

7. Click Add after you specify the Qualifier Type and Qualifier Value; both are 
added to the area in the lower portion of the window.  Note the illustration. 
 

  
 
To remove an individual qualifier type/value combination from the property, 
highlight the appropriate line in the display area and click Remove.  To clear all 
displayed qualifier type/value combinations, click Clear.   
 
You have the option of filtering the property qualifier types that are available 
from the Qualifier Type field dropdown list by creating a pre-defined, filtered list 
of types.  When you attempt to select a qualifier type from the Qualifier Type 
field dropdown list, or select an alternate Qualifier type, only the pre-selected 
property types will be included in the list.  Refer to the Filter Property Qualifier 
Types discussion earlier in the guide.   
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8. Click OK on the Add Property window to add the property to the current local 
namespace.  When you expand the Properties folder for the concept on the 
Concept/Term Details panel, the property displays in italics (to indicate that it is 
subscription content that was written to a local namespace).  Click Cancel to 
ignore the new property. 

Edit a Concept Property 
Follow this procedure to view and/or edit a property that was created in a local 
namespace for a concept or term in a subscription namespace.   

1. Drag the concept/term containing the property you want to view or edit from 
another panel and drop it on into the Concept/Term Details panel. 

2. On the Concept/Term Details panel, expand the Properties folder to display 
existing properties for the concept/term. 

3. Right-click on the property for which you want to view or edit details, then select 
Modify Property from the displayed options.  (Properties created as local content 
display in italics; the Modify Property option is available for these properties 
only.)  The Modify Property window displays. 
 

 
 
The concept/term from the Concept/Term Details panel displays in the 
Concept/Term field, and is not editable.  The namespace in which the 
concept/term resides displays in brackets.   

4. A property type is a pre-established identifier that defines the property.  From the 
Property Type field dropdown list, select an alternate property definition to be 
assigned to the concept or term.  If the Concept/Term is from a subscription 
namespace, the Property Type dropdown list includes only property types created 
in the current local namespace, listed alphabetically.   
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If the Concept/Term was created in a local namespace, the Property Type list 
includes property types created in the current local namespace, but only if the 
Concept/Term also was created in the current local namespace.  If the 
concept/term was not created in the current local namespace, the Property Type 
field dropdown list will be empty.  Refer to the Property Types discussions. 
 
You have the option of filtering the property types that are available from the 
Property Type field dropdown list by creating a pre-defined, filtered list of types.  
When you attempt to select a type from the Property Type field dropdown list, or 
select an alternate property type, only the pre-selected types will be available in 
the list.  Refer to the Filter Property Types discussion earlier in the guide.   

5. For the property type (definition) assigned to this concept or term, you can modify 
the property value in the Property Value text area. 

6. For each property you can specify an established qualifier type and value; these 
provide additional detail regarding the nature of a concept or term property (e.g., 
Current).  From the Qualifier Type field dropdown list, select the qualifier 
assigned to this property.  The list includes only those property qualifier types 
that were created in the same local namespace where the selected property type 
was created; refer to the Property Qualifier Types discussions. 

7. For the property qualifier (type) you selected for this concept or term, specify the 
qualifier value in the Qualifier Value field.  For each property you can create 
multiple qualifiers with different qualifier types, or multiple occurrences of the 
same qualifier type, each with a separate value.   

8. Click Add after you specify the Qualifier Type and Qualifier Value; both are 
added to the display area in the lower portion of the window.  See the illustration. 
 

 
 
To remove an individual qualifier type/value combination from the property, 
highlight the appropriate line in the display area and click Remove.  To clear all 
displayed qualifier type/value combinations, click Clear.   
 
You have the option of filtering the property qualifier types that are available 
from the Qualifier Type field dropdown list by creating a pre-defined, filtered list 
of types.  When you attempt to select a qualifier type from the Qualifier Type 
field dropdown list, or select an alternate Qualifier type, only the pre-selected 
types will be available in the list.  Refer to the Filter Property Qualifier Types 
discussion earlier in the guide.   
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9. Click OK on the Modify Property window to add the property edits to the current 
local namespace.  Click Cancel to ignore the edits. 

Delete a Concept Property 
Follow this procedure to delete an existing property from a concept, if the property was 
written to a local, writable namespace.   

1. Drag the concept/term containing the property you want to delete into the 
Concept/Term Details panel. 

2. On the Concept/Term Details panel, expand the Properties folder to display 
existing properties for the concept/term. 

3. Right-click on the property you want to delete, then select Delete Property from 
the displayed options.  Note that the Delete Property option is not available if the 
displayed concept exists in a namespace that is not writable. 
 
A delete confirmation window similar to the following displays.  
 

 
4. Click OK to delete the concept/term property from the concept in the local 

namespace.  Click Cancel to ignore the deletion. 

Create an Association 
Use one of the following methods to add an association (with an association type 
established as local content in a local namespace) between concepts or terms in a 
subscription namespace.  The association can be between concepts or terms within one 
namespace, or across different namespaces. 

Create an Association – Click on Concept Name in the Concept/Term Details Panel 

Follow this procedure to add an association definition and target concept value to the new 
concept by right clicking on the new concept name in the Concept/Term Details panel. 

1. Drag the relationship from concept/term into the Concept/Term Details panel.   

2. Right-click on the concept/term name on the Concept/Term Details panel, then 
select Add Association from the displayed options.  The Add Association window 
displays. 
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The from concept/term from the Concept/Term Details panel displays 
automatically in the From Concept/Term field, establishing the From portion of 
the From/To association between concepts or terms.  The namespace in which 
the from concept resides displays in brackets.  

3. From the Association Type field dropdown list, select the type of association (e.g., 
Related To, Child Of) you are creating between the concepts or terms.  
Association types from the current local namespace are listed alphabetically.  
Refer to the Association Types discussions. 
 
You have the option of filtering the association types that are available from the 
Association Type field dropdown list by creating a pre-defined, filtered list of 
types.  When you attempt to select an association type from the Association Type 
field dropdown list, or select an alternate association type, only the pre-selected 
types will be included in the list.  Refer to the Filter Association Types discussion 
earlier in the guide. 

4. From another displayed panel or window, drag the target concept/term in the 
association in the To Concept/Term dropdown field.  The namespace in which the 
to concept resides displays in brackets to the right of the field.  
 

 
5. For each association you can add one or more qualifiers, each of which consists of 

an established qualifier type and value.  Qualifiers provide additional detail 
regarding the nature of a concept or term association (e.g., Usually).   
From the Qualifier Type field dropdown list, select a qualifier type to assign to 
this association.   
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The list includes only those association qualifier types that were created in the 
same local namespace where the selected Association Type was created (refer to 
the Association Qualifier Types discussions).  The namespace in which the 
qualifier type was created displays in brackets.     

6. For the qualifier (type) you selected for this association, specify the qualifier 
value in the Qualifier Value field.  For each association you can create multiple 
qualifiers of different types, or create occurrences of the same qualifier type, each 
with a separate value.   

7. Click Add after you specify the Qualifier Type and Qualifier Value; both are 
added to the display area in the lower portion of the window (see the illustration).  
 

 
 
To remove an individual qualifier type/value combination from the association, 
highlight the appropriate line in the display area and click Remove.  To clear all 
displayed qualifier type/value combinations, click Clear.   
 
You have the option of filtering the association qualifier types that are available 
from the Qualifier Type field dropdown list by creating a pre-defined, filtered list 
of types.  When you attempt to select an association qualifier type from the 
Qualifier Type field dropdown list, or select an alternate Qualifier type, only the 
pre-selected types will be included in the list.  Refer to the Filter Association 
Qualifier Types discussion earlier in the guide.   

8. Click OK on the Add Association window to add the association. 

Create an Association – Control/Drag Concept into the Concept/Term Details Panel 

Follow this procedure to create an association definition and target concept value for the 
new concept using the concept Control/Drag option.   

1. Make sure the from concept for which you want to add an association (e.g., Drug 
Testing) displays in the Concept/Term Details panel.   

2. From another displayed panel, or another instance of the Concept/Term Details 
panel, select the concept you want to add as the target concept in the association 
(e.g., Pathology and Laboratory Tests) then drag it to the Concept/Term Details 
panel.  Hold the Control key down before you drop this concept into the 
Concept/Term Details panel.  The Add Association window displays. 
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3. Both the From and To concept/terms display automatically in the appropriate 
fields.  The namespace in which each concept resides displays in brackets.   
 

 
From the Association Type field dropdown list, select the type of association (e.g., 
Likened To, Related To) you are creating between the concepts or terms.  
Association types from the current local namespace are listed alphabetically.  
Refer to the Association Types discussion. 
 
You have the option of filtering the association types that are available from the 
Association Type field dropdown list by creating a pre-defined, filtered list of 
types.  When you attempt to select an association type from the Association Type 
field dropdown list, or select an alternate association type, only the pre-selected 
types will be included in the list.  Refer to the Filter Association Types discussion 
earlier in the guide. 

4. For each association you can add one or more qualifiers, each of which consists of 
an established qualifier type and value.  Qualifiers provide additional detail 
regarding the nature of a concept or term association (e.g., Usually).   
 
From the Qualifier Type field dropdown list, select a qualifier type to assign to 
this association.  The list includes only those association qualifier types that were 
created in the same local namespace where the selected association type was 
created (refer to the Association Qualifier Types discussions).  The namespace in 
which the qualifier type was created displays in brackets.     

5. For the qualifier (type) you selected for this association, specify the qualifier 
value in the Qualifier Value field.  For each association you can create multiple 
qualifiers of different types, or create occurrences of the same qualifier type, each 
with a separate value.   
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Click Add after you specify the Qualifier Type and Qualifier Value; both are 
added to the area in the lower portion of the window.  Note the illustration.  
 

 
 
To remove an individual qualifier type/value combination from the association, 
highlight the appropriate line in the display area and click Remove.  To clear all 
displayed qualifier type/value combinations, click Clear.   
 
You have the option of filtering the association qualifier types that are available 
from the Qualifier Type field dropdown list by creating a pre-defined, filtered list 
of types.  When you attempt to select an association qualifier type from the 
Qualifier Type field dropdown list, or select an alternate Qualifier type, only the 
pre-selected types will be included in the list.  Refer to the Filter Association 
Qualifier Types discussion earlier in the guide.   

6. Click OK on the Add Association window to add the association. 

Create an Association – Control/Drag Association into the Concept/Term Details Panel 

Follow this procedure to select an existing local association itself from a target concept 
displayed in another panel, then add the association itself to the new concept in the 
Concept/Term Details panel using the concept Control/Drag option.   

1. Make sure the from concept for which you want to add an association (e.g., Drug 
Testing) displays in the Concept/Term Details panel.  

2. From a target concept displayed in another panel or window (or in another 
instance of the Concept/Term Details panel) select the local association you want 
to add.  Select the local association itself (not the concept); local associations 
display in italics.  

3. Drag the target concept association to the Concept/Term Details panel where the 
association from concept is displayed.  Hold the Control key down before you 
drop the target concept association into the Concept/Term Details panel where 
the from concept is displayed.  The dragged target concept association displays 
(in italics) in the Associations folder for the association from concept displayed 
in the Concept/Term Details panel.    
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Create a Concept/Term Association within a Namespace 
The following procedure illustrates how to create an association between concepts or 
terms within the same namespace.  In the example shown, an association is created 
between two concepts in the ICD-9-CM namespace.   

1. In the DTS Editor Main window, open one or more display panels that include the 
concepts or terms for which you want to create an association.  The panel displays 
should reflect the same namespace (in this case, ICD-9-CM).  In the illustration, 
the Concept Tree panel reflects both concepts that will be included in the 
association (Diabetes mellitus and Diabetes with ketoacidosis).  
 

 
 
Another option is to open the Search panel in the left pane, which reflects the 
concept Diabetes mellitus in the ICD-9-CM namespace.  The Concept Walker 
floating window reflects Diabetes with ketoacidosis as a child concept of 
Diabetes mellitus, also in the ICD-9-CM namespace.  Note the illustration.   
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2. Drag the relationship from concept/term (i.e., Diabetes with ketoacidosis) into 
the Concept/Term Details panel.   

3. Right-click on the concept/term name on the Concept/Term Details panel, then 
select Add Association from the displayed options.  The Add Association window 
displays.  The from concept/term from the Concept/Term Details panel (i.e., 
Diabetes with ketoacidosis) displays automatically in the From Concept/Term 
field, establishing the From portion of the From/To association between 
concepts or terms.   
 

 
 
The association always is written to the From Concept namespace (in this case, 
ICD-9-CM), which displays in parentheses next to the concept/term.   

4. Drag Diabetes mellitus from the other displayed panel and drop it into the To 
Concept field.  The namespace (again, ICD-9-CM) displays in parentheses next 
to the concept/term. 
 

 
5. The Association Type field dropdown list includes only association types created 

in the current local namespace; select the type of association you are establishing.  
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In the illustration, Part Of is selected; the local namespace in which that 
association was created displays in parentheses.  
 

 
6. Select the appropriate qualifiers for this association using the Qualifier Type field 

dropdown list, then enter the value for each qualifier type. 

7. Click OK to update the ICD-9-CM namespace with the association of the 
concept Diabetes with ketoacidosis as being Part Of the concept Diabetes 
mellitus.  Click Cancel to ignore the new association. 

Map Concept/Terms across Namespaces 
The DTS Editor allows you to create associations between concepts or terms across many 
namespaces.  Using this mapping approach (i.e., creating sets of associations between 
concepts in two or more namespaces) you can map a single From Concept to many To 
Concepts across multiple namespaces.    
 
The following procedure illustrates how to create an association between concepts or 
terms across two namespaces.  In the example shown, an association is created for the 
concept diabetes mellitus, which exists in both the SNOMED CT and ICD-9-CM 
namespaces.   

1. Open two separate display panels in the DTS Editor Main window.  The display 
in each should include the concept/term (each reflected in a separate namespace) 
for which you want to create an association.  
 
In the illustration, the Concept Walker panel reflects the concept diabetes 
mellitus in the ICD-9-CM namespace.  The Concept Tree floating window 
reflects the concept diabetes mellitus in the SNOMED CT namespace. 
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Another option is to open two instances of the Concept Tree floating window, 
each of which include the concept diabetes mellitus in its respective namespace.  
Note the following illustration.   
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2. Drag the relationship from concept/term, Diabetes mellitus in the from 
namespace (i.e., SNOMED-CT) into the Concept/Term Details panel.   

3. Right-click on the concept/term name on the Concept/Term Details panel, then 
select Add Association from the displayed options.  The Add Association window 
displays.  The from concept/term from the Concept/Term Details panel (i.e., 
Diabetes mellitus) displays automatically in the From Concept/Term field, 
establishing the From portion of the From/To association between concepts or 
terms.   
 

 
 
The association always is written to the From Concept namespace (in this case, 
SNOMED-CT), which displays in parentheses next to the concept/term name.   

4. Drag the relationship to concept/term, Diabetes mellitus in the to namespace 
(i.e., ICD-9-CM) and drop it into the To Concept field on the Associations 
window.  The namespace (in this case, ICD-9-CM) displays in parentheses next 
to the concept/term. 
 

 
5. The Association Type field dropdown list includes only association types created 

in the current local namespace; select the type of association you are establishing.  
In the illustration, Same As is selected; the local namespace in which that 
association was created displays in parentheses.  
 

 
6. Select the appropriate qualifiers for this association using the Qualifier Type field 

dropdown list, then enter the value for each qualifier type. 

7. Click OK to update the SNOMED CT namespace with the association of the 
concept diabetes mellitus between the namespaces SNOMED CT and ICD-9-
CM.  Click Cancel to ignore the new association. 
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View and Edit an Existing Association 
Follow this procedure to view or edit an association definition and target concept value 
for a concept by right clicking on the concept name in the Concept/Term Details panel. 

1. Drag the from concept/term in the from/to relationship you want to view into the 
Concept/Term Details panel. 

2. On the Concept/Term Details panel, expand the Associations folder to display 
existing associations for the concept. 

3. Right-click on the association for which you want to view or edit details, then 
select Modify Association from the displayed options.  The Modify Association 
window displays. 
 

 
 
The concept/term from the Concept/Term Details panel displays in the From 
Concept/Term (drop target) field; this establishes the From portion of the 
From/To association.  The namespace in which the from concept resides displays 
in brackets.   
 
The target concept/term in the association displays in the To Concept/Term (drop 
target) field.  The type of association (e.g., Approach) that was established 
displays in the Association Type field. 

4. The modified association that you enter will be written to the local namespace 
where the association type is defined.  In the Association Type field list, select the 
type of association between the concepts or terms.  Association types from the 
current local namespace are listed alphabetically (see Association Types). 
 
You have the option of filtering the association types that are available from the 
Association Type field dropdown list by creating a pre-defined, filtered list of 
types.  When you attempt to select an association type from the Association Type 
field dropdown list, or select an alternate association type, only the pre-selected 
types will be included in the list.  Refer to the Filter Association Types discussion. 
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5. For each association you can add or remove one or more qualifiers, each of which 
consists of an established qualifier type and value.  Qualifiers provide additional 
detail regarding the nature of a concept or term association (e.g., Usually).  From 
the Qualifier Type field dropdown list, select a new qualifier type to assign to this 
association.  The list includes only those association qualifier types that were 
created in the same local namespace where the selected association type was 
created. 

6. Click Add after you specify the Qualifier Type and Qualifier Value; both are 
added to the display area in the lower portion of the window.   
 
To remove an individual qualifier type/value combination from the association, 
highlight the appropriate line in the display area and click Remove.  To clear all 
existing qualifier type/value combinations, click Clear.   
 
You have the option of filtering the association qualifier types that are available 
from the Qualifier Type field dropdown list by creating a pre-defined, filtered list 
of types.  When you attempt to select an association qualifier type from the 
Qualifier Type field dropdown list, or select an alternate Qualifier type, only the 
pre-selected types will be included in the list.  Refer to the Filter Association 
Qualifier Types discussion earlier in the guide.  

7. Click OK to update the knowledgebase with your association edits.  Click Cancel 
to ignore the edits.  

Delete an Association 
Follow this procedure to delete an association that exists between concepts or terms 
within a namespace, or across namespaces.  The association type for the association you 
want to delete must exist in a local namespace in order for you to delete the association.   

1. Drag the from concept/term in the association you want to delete into the 
Concept/Term Details panel. 

2. On the Concept/Term Details panel, expand the Associations folder to display 
existing associations for the concept. 

3. Right-click on the association you want to delete (in a subscription namespace, 
the association should be in italics) then select Delete Association from the 
displayed options.  A delete confirmation window displays. 
 

 
4. Click OK to delete the concept/term association from the local namespace to 

which it was written originally.  Click Cancel to ignore the deletion. 
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Code and ID Generator 
Introduction 
Concept codes and concept IDs are identifiers generated automatically and assigned to 
each new concept or term you create through the DTS Editor.  The concept code and ID 
display in the Concept Tree panel (in parentheses) next to each concept name when you 
right-click on the concept name. 

The default format for each new generated ID is the next available number in sequence.  
The default format for each new code generated is a prefix of letter C for concepts, or 
letter T for terms, followed by the next available number in sequence (e.g., C1, C2, C3, 
T1, T2, T3, etc.).  The default format for new concept code and ID generation is defined 
in the class com.apelon.dts.client.plugins.DefaultCodeAndIdGenerator.  

You have the option of writing and “registering” one or more customized code and ID 
generators.  Each new generator can define parameters for generation of new codes and 
IDs based on formats of your own design.  Each new generator would extend 
CodeAndIdGenerator based on the new class in com.apelon.dts.client.common.   

To create a new code and ID generator, you first must write and compile a java class for 
it (and place the compiled custom code and ID generator under a plugins subfolder of 
their DTS installation).  You then must register the new code generator .class file (which 
makes it the current generator for creation of codes and IDs for new concepts or terms in 
the DTS Editor).  Procedures for each of these steps are provided. 

Writing and Compiling a Code and ID Generator 
A code generator is a java class that must extend the abstract CodeAndIdGenerator class 
found in package: com.apelon.dts.client.common. There are three methods that must be 
implemented in the java class, getCode (DTSobjectconceptOrTerm) getId 
(DTSobjectconceptOrTerm) and getDescription().  Each method is described. 

• getCode(DTSobject conceptOrTerm) – the return value from this method will be 
passed to the concept for which a code must be assigned. This method should 
return a Java string type of 32 characters or less. This code will be assigned to the 
concept when the concept is saved in the DTS Editor.  

• getDescription() will return a Java string that describes the code generation 
method for this code generation class. You will see this description in the DTS 
Editor, when you select a code generator from the Register Code Generator 
window (this window is discussed in detail later). 

• getId (DTSobject conceptOrTerm) 

An example of a code generator class is shown; note that the .class file must have a 
unique name.  The methods described are shown in the example. 
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Note: Code generators must be placed in package: com.apelon.dts.client.plugins and 
must extend class: com.apelon.dts.client.common.CodeAndIdGenerator.  

package com.apelon.dts.client.plugins; 
 
import com.apelon.apelonserver.client.ServerConnection; 
import com.apelon.dts.client.common.CodeAndIDGenerator; 
import com.apelon.dts.client.common.DTSObject; 
import com.apelon.dts.client.term.Term; 
 
import java.util.Random; 
 
/** 
 * Sample code and ID generator that generates a random ID and corresponding 
 * code for the passed concept or term. 
 */ 
public class SampleCodeAndIdGenerator extends CodeAndIDGenerator { 
  private String fCode; 
  private int fId = -1; 
 
  /** 
   * Constructor passing server connection.  The server connection can be used 
   * to instantiate DTS query classes in case they are needed to determine a 
   * unique code and ID.  The server connection is not used in this sample code 
   * and ID generator. 
   * 
   * @param      sc               server connection 
   */ 
  public SampleCodeAndIdGenerator(ServerConnection sc) { 
    super(sc); 
  } 
 
  public String getCode(DTSObject conceptOrTerm) { 
    if (fCode == null) { 
      setRandomCodeAndID(conceptOrTerm); 
    } 
 
    return fCode; 
  } 
 
  private void setRandomCodeAndID(DTSObject conceptOrTerm) { 
    Random r = new Random(); 
    fId = r.nextInt(); 
    if (conceptOrTerm instanceof Term) { 
      fCode = "T" + fId; 
    } else { 
      fCode = "C" + fId; 
    } 
  } 
 
  public int getId(DTSObject conceptOrTerm) { 
    if (fId == -1) { 
      setRandomCodeAndID(conceptOrTerm); 
    } 
 
    return fId; 
  } 
 
  public String getDescription() { 
    return "Generates a random ID for a new concept or term.  " 
    + "For the code it prepends a capital \"C\" to the generated ID of a concept, " 
    + "or a capital \"T\" to the ID of a term."; 
  } 
} 
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The compplugins.bat file included in the DTS install is located in the bin\editor 
directory, under the DTS main directory. To compile a code and ID generator source file, 
place the source file in this directory:  
 
                         DTSInstall\plugins\src\com\apelon\dts\client\plugins  

Run the compplugins.bat file. You must have the path to your JDK on your PATH 
environment variable for this .bat file to compile your code and ID generator. Your 
compiled code and ID generator now will be available in the DTS Editor. 

You also may use your own third-party java source editor (e.g., JBuilder, Visual Age) to 
compile your code and ID generator. You will need the ApelonDTS.jar on your 
CLASSPATH to compile; this .jar file will contain the CodeAnd IdGenerator class that 
all code and ID generators must extend. 

 
After you compile the class successfully, place the resulting .class file into this directory 
on your local hard drive:  

                    Apelon\ DTSInstall\plugins\classes\com\apelon\dts\client\plugins 

This path originates from the location of your DTS Editor install. Only code and ID 
generators placed in this directory will be available while using the DTS Editor. 

Registering a Code and ID Generator 
Follow these procedures to register a new code and ID generator.  All concepts created 
thereafter will have codes and IDs generated based on the registered generator 
parameters. 

1. Select Code and ID Generator from the DTS Editor main window Options 
menu.  The Select Code and ID Generator window displays. 
 

 
 
The window lists each code and ID generator for which a Java class file was 
created, compiled, and placed in the plugins\classes\com\apelon\dts\client\ 
plugins directory.  The code and ID generator currently in effect displays at the 
top of the window. 
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Note: The sample file DefaultCodeAndIdGenerator.java is included in the 
plugins\src\com\apelon\dts\client\plugins directory.  Run the file 
compplugins.bat in the DTSInstall\bin\editor directory to compile this Java file 
for the sample code and ID generator.  
 
com.apelon.dts.client.plugins.DefaultCodeAndIdGenerator then displays as an 
option in the Select Code and ID Generator window. 

2. Click the desired code and ID generator to select it.  A brief description of the 
code format that is generated displays. 
 

 
 
The default format for each new generated ID is the next available number in 
sequence.  The default format for each new code generated is the newly generated 
ID, with a prefix of letter C for concepts, or letter T for terms (e.g., the new IDs 1, 
2, and 3 would generate codes of C1, C2, C3, etc, for concepts, and T1, T2, T3, 
etc. for terms).   

3. Click OK to register the new code and ID generator.  Each new concept created 
from this point will be assigned an ID and code based on the associated generator 
parameters in the java class file. 

Duplicate Codes 
If the new code and ID generator you registered creates a code that is identical to one 
already in the knowledgebase, a message displays indicating that The concept/term 
already exists!. 

You have the following two options at this point: 

1. Click OK.  The concept or term will not be created.  Try creating the concept or 
term again; possibly the code and ID generator will generate a unique code and ID 
the next time. 

2. If duplicate codes are being generated on a consistent basis, register a different or 
updated code and ID generator on the Select Code and ID Generator window. 
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Sample Code and ID Generator 
An alternative, "sample" code and ID generator is available with DTS .  Rather than 
automatically generating a code and ID like the default code and ID generator, it permits 
you to manually enter the code and ID for a new concept or term.   

The class name is com.apelon.dts.client.plugins.PromptForCodeAndId; it will be 
included in the list of code and ID generators until you compile it by running the 
compplugins.bat file.  The source in DTSInstall\plugins\src\com\apelon\dts\client\ 
plugins will be compiled into the output directory DTSInstall\plugins\classes\com 
\apelon \dts\client\plugins.   
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Appendix A – Adjust Memory for Remote JDBC Connections 
DTS loads the Lexicon dictionary whenever you perform a silo search using the DTS 
Editor.  If you use a Remote JDBC connection to the database, and experience Out of 
Memory errors when you attempt silo searches, you may need to increase the amount of 
heap memory configured for the DTS Editor. 

Perform the following procedure to adjust the installed heap memory. 

1. Right-click the Apelon DTS Editor selection on the Windows Start menu 
(Programs>Apelon>DTSInstall>Apelon DTS Editor). 

2. When the options list displays, click Properties. The Apelon DTS Editor 
Properties window displays, with the Shortcut tab selected. 
 

 
3. In the Target field, set the value for the first argument to the desired maximum 

Java heap size (consider the total amount of memory you have available when 
deciding how much to allocate to the DTS Editor).  Replace the installed default 
value of 256, which refers to the amount of heap memory in megabytes.   

4. Click OK to reset the heap size value. 

5. Confirm that the Apelon DTS Server is running (Start>Programs>Apelon> 
DTSInstall>Start Apelon DTS Server) then start the DTS Editor. 

Back to Top 
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